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SMath is a program for performing and documenting engineering calculations. An SMath
document consists of formulas, texts, diagrams, and images freely arranged on the page.
Formulas can be assembled from calculator-like palettes or from the keyboard without
using the mouse (much faster for experienced users). There is excellent support for units of
measurement. The formulas serve as both computational instructions and documentation.
Formulas appear in natural mathematical notation (not like program code), allowing even
those unfamiliar with the program to understand them.

SMath originated as a hobby project by Andrey Ivashov, a software developer from Saint
Petersburg. It is now developed and supported by LLC SMath (ÎÎÎ Ýñìàò), of which
Andrey Ivashov is the managing director. The program gained signi�cance within the
context of the sanction relief e�orts for the Russian economy and science, as it can replace
the conceptually similar MathCAD by PTC (USA).

SMath is closed source commercial software. There is a free personal license plan (requir-
ing registration). This plan has no restrictions of the mathematical features but does not
include commercial use.

SMath features an integrated extension manager. This provides access to an online gallery
where the community can publish program extensions (plug-ins), application examples,
documentation, and code snippets. The present manual is also available there.

The author of this manual has extensive experience in using SMath Studio for research
and teaching at the University of Applied sciences Brandenburg (THB) in Brandenburg an
der Havel, Germany. He is active on the user forum at smath.info. Major contributions to
the community are a comprehensive German handbook (Kraska 2020) and the Maxima-
plugin, an interface to the free and open-source computer algebra program Maxima. This
interface provides features such as symbolic integration and equation solving, as well as
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CHAPTER 1. INTRODUCTION

three-dimensional diagrams. This is what could be Germany's concept of success: Take
the best from East and West and combine it for the bene�t of everyone.

This manual was written in parallel to a major rework of the Maxima Plugin and wants
to encourage SMath users to actually try it.

We assume that you are already familiar with SMath and have a working installation at
hand. Knowledge of Maxima would be helpful but is not mandatory.

Some chapters have �le attachments (below the chapter table of contents). You can �nd
them in the attachment view of your PDF viewer.
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1.2 What You Get

Menu entry Main menu> Insert>Maxima

This entry provides access to the Log and Debug Dialogs, the Settings form, Maxima
plot regions, called Draw2D and Draw3D regions and to the Maxima help page.

Maxima palette in the side panel for insertion of Maxima functions to the canvas.

Function Maxima(), which hands over expressions to Maxima for evaluation and returns
the result to SMath. The currently implenented translation capabilities already
cover a signi�cant part of Maxima's features. There is full support for units of
measurement, text indices and UTF8 encoding.

Symbolic alternatives to SMath Functions

� Int() for de�nite and inde�nite integration

� Lim() for limits, also one-sided limits are supported by adding +'0 or -'0 (a
zero marked as unit) to the point.

� Diff() for derivatives

� Det() for determinants

� Sum() for sums

� Cross() for cross products. It has a permanent operator form
(smaller than the original SMath cross product symbol).

The function MaximaTakeover() redirects the native SMath functions to the above-
mentioned alternatives. The advantage of redirection is better readabilty by use of
the native operator symbols:

� SMath without Maxima

� SMath with Maxima and enabled redirection (takeover)

Martin Kraska 8 2023-09-29



CHAPTER 1. INTRODUCTION

Wrapper functions for some Maxima features:

� Solve() symbolic solution of algebraic linear and non-linear equations and
systems of equations (chapter 7)

� ODE.2() symbolic solution of di�erential equations (chapter 8)

� Fit() for non-linear least square �ts of data to parametric functions (chapter
6)

� MSE() mean square error between data and model

� Residuals() residuals between data and model

� Functions Draw2D() and Draw3D() for creating plots (chapter 3). These can be
displayed using Image regions (plugin ImageRegion). The functions use Maxima's
draw package which actually uses Gnuplot as a back end.

� Draw regions (section (3.7)). They take the same commands as Draw2D() and
Draw3D() but provide interactive mouse control for sizing, scaling, rotation and
have a settings form for common plot options.

� Support of real and complex numbers, strings, lists and matrices.

Restrictions:

� The interface doesn't work under Linux.

� No support for names containing special characters produced using Ctrl-K .

� No units support for numerical procedures in Maxima.

� Boolean expressions are translated but have a di�erent meaning in Maxima. Maxima
has a data type boolean, which can assume the values true or false. In SMath
this corresponds to numeric values zero for false and non-zero for true.

� There are restictions for the length of expressions due to the translation by regular
expressions.

� The Maxima plugin is in beta-state of development. Not everything works as ex-
pected and things may change in the future.

Maxima on the web:

� Maxima Homepage1 on Sourceforge,

� Maxima Overview2 Quick overview

� O�cial index of handbooks and tutorials3

1maxima.sourceforge.net
2http://www-com.physik.hu-berlin.de/~bunk/kurs/maxima/maxima.html
3http://maxima.sourceforge.net/docs/manual/de/maxima_12.html#SEC79
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CHAPTER 1. INTRODUCTION

1.3 Installation of the Plugin

Just like any other extension, the Maxima plugin is installed via the Extensions Manager
from within an SMath session:

� Tools> Plugins

� Make sure to switch to the online gallery and unselect �exclude beta versions�:

� Select the MaximaPlugin from the list.

� Press Install and wait for the installation of the plugin.

Usually, there is no need to perform a restart of the SMath application.

When the installation is �nished, the �Settings� dialog pops up. Otherwise you can call
the dialog via Insert> Maxima> Settings from the main menu.

Note: the plugin is just the interface between SMath and Maxima. Maxima is not included
in the plugin. You can point to an existing installation of Maxima or you can use the
Install button. These options are described in the next section.

Martin Kraska 10 2023-09-29
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1.4 Installation of Maxima

Open the Settings dialog: Insert> Maxima> Settings

You already have a working Maxima installation on your computer?

1. Use the �le selector ... to indicate the path to your installation. It is su�cient to
point to the top level directory, e.g. C:\maxima-5.47.0.

2. Press Save . SMath starts searching for maxima.bat and tries to launch Maxima.
If that works, just con�rm the message.

You don't have Maxima on your computer? For a standard installation you need
Internet connection and admin privileges. The installation will take slightly more than
700 MB of disk space.

Press Install and select one of the install options:

It should be safe to use the silent installation. In any case, the installation is a two-step
process: download and the actual installation. The software is downloaded using the
o�cial links. SMath does not modify the installation in any way.

Upon �nishing, the Settings window is closed and a Maxima session is launched in the
background. Check the Insert menu for a Maxima submenu

In the side panel you should �nd the Maxima palette with quick access buttons.
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1.5 Other Useful Plugins

Custom Glyphs provides nice operator forms for SMath functions.

Custom Functions provides the substitution function at(), which is very comfortable
to use with results of any kind of algorithms (solver, curve �t).

Development Tools provides convenient access to the installation directory of the Max-
ima plugin. In this directory Maxima stores temporary graphics �les and the
con�guration �le maxima.xml. Select Insert> Development Tools> Plugin's
folder> MaximaPugin.

ImageRegion plugin provides a region for display of image �les generated by Maxima's
Draw2D() and Draw3D() functions. This is the most transparent way to use Maxima
plotting, while using the Maxima Draw regions is more convenient.
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1.6 The Maxima Session

As soon as any of the Maxima-based features is used in an SMath document, a Maxima
session is established via TCP/IP connection. You �nd this process as sbcl.exe (Steel
Bank Common Lisp) in the Windows task manager.

� Each SMath instance has it's own Maxima process, which communicates with the
currently open SMath document.

� Once started, the Maxima session is kept open.

� The session can be reset using the function MaximaControl(). The argument
"restart" closes the session and starts a new one. The Argument "cleanup"

just let's Maxima forget de�ned variables and loaded packages.

Alternatively you can issue a restart using Insert> Maxima> Settings: Save.

� Switching between open document in a single instance of SMath can have side
e�ects, because all documents of a given SMath instance share the same Maxima
process.

To be safe, insert MaximaControl("restart")= in your documents before using any
Maxima feature. Opening just one sheet per SMath instance completely avoids the
problem.

� Save your work frequently. Maxima oder SMath actually can crash. Usually, the
plugin manages to kill crashed Maxima sessions. If not, �nd and kill the process
sbcl.exe (Steel Bank Common Lisp-Interpreter) using the Windows task manager.
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1.7 Replacement of Functions (Takeover)

The interface is under development, so the redirection (takeover) of SMath native func-
tions by Maxima is deactivated by default. For activation and deactivation we have the
function

MaximaTakeover(). The function accepts one or more string parameters, which are searched
for the keys given in table 1.1 to redirect individual functions or �all� for all (as you
might guess). If none of these are found, redirection is deactivated.

This redirection can be done at any location in the SMath sheet and is valid until the next
call to MaximaTakeover(). It is also reset by restart or cleanup using MaximaControl().
Note that the takeover state can only be changed by functions on the sheet, not by menu
commands like Insert> Maxima> Settings> Save or Insert> Maxima> Restart.

Function Key SMath Operator Maxima

Derivative �di�� diff(1) Diff(1)

diff(2) Diff(2)

diff(3) Diff(3)

Inde�nite integral �int� int(2) Int(2)

De�nite integral �int� int(4) Int(4)

Determinant �det� det() Det()

Limit �lim� lim() Lim()

Sum �sum� sum(4) Sum(4)

Table 1.1: SMath functions and corresponding Maxima functions available via
MaximaTakeover(). The capitalized Maxima functions are always available,
yet they don't have operator representations.

Symbolic results from Maxima can be displayed using Optimization> Symbolic or Opti-
mization> None in the context menu of the formula. In case of �Symbolic� SMath tries
to further simplify the result, not always to the better. It is sometimes worth a try to
switch o� optimization.
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1.8 The Maxima() Function

This function

1. Takes an SMath expression (which SMath tries to handle before it is actually sent
to the function).

2. Translates it to Maxima syntax.

3. Uses this as input for the current Maxima session.

4. Translates the Maxima output to SMath

This is the most general way to use Maxima from within SMath. Frequently it is just
used to simplify SMath expressions.

Die Maxima()function has an operator form (Maxima logo), which in earlier versions was
provided by the Custom Glyphs plugin, but now is part of the Maxima plugin itself.

Object SMath Maxima
Decimal separator Comma or period Period
Argument separator Semicolon or comma Comma

Text index a_%_b

Underscores in names a_b

Special constants e, i %e, %i

Lists (systems) []

Matrices matrix()

Element index v[j]

Strings "abc"

Units %unitcm

Table 1.2: SMath objects and their representation in Maxima

Usually translation of names to Maxima and back to SMath should yield the original
name. The function MaximaLog() reveals what happens behind the scene. It shows the
most recent input/output pair of the Maxima session.

To inspect the translation steps use the debug window under Insert> Maxima> De-
bug.
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1.9 The Log Window

The communication between SMath and Maxima is logged by default. The log window
is called either from the canvas by MaximaLog("all") or via Insert> Maxima> Log.

There are three types of logs:

� Maxima communication: This is a concatenation of the strings exchanged be-
tween SMath and Maxima

� Full conversion: For each request to Maxima, this log shows

� The SMath expression in text format

� The translation to Maxima

� The response from Maxima

� The translation to SMath in text format

� wxm: This contains the commands sent to Maxima formatted as wxMaxima input.

The button Save as.. o�ers a dialog to save the log. In the case of wxm format, the log
is sent to wxMaxima (the standard GUI of Maxima).

Martin Kraska 16 2023-09-29



CHAPTER 1. INTRODUCTION

1.10 MaximaLog()

MaximaLog(■)

shows the last input and output of Maxima with the respective labels.

MaximaLog("all")

displays Maxima input and output of the running Maxima session beginning from the
last restart or cleanup or manual log reset. The output may be quite large. In this case,
it is better to use the interactive Log window. This log is a simple concatenation of the
strings exchanged between SMath and Maxima.
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2.1 Algebra

Display of Maxima results is best with Context menu> Optimization> None.

Factor and Expand

Complex Numbers

Big Floats

MaximaDefine() is used to set values in the background Maxima session. A common
usage is to set control variables:

fpprec Precision for �oating point operations

fpprintprec Precision for output of �oating point values
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Cross Product

The native SMath cross product has two limitations: It can't handle vectors which are
multiplied by unde�ned variables, because in contrast to Maxima, SMath doesn't assume
that such a factor is a scalar. The other restriction is that it can't handle 2D vectors.

The Maxima plugin provides two ways to handle this.

� Wrap the native cross product with the Maxima() function:

� Use the dedicated function Cross() with a permanent custom operator form (not
a�ected by MaximaTakeover())

Eigenvalues

Maxima has functions for extracting eigenvalues and eigenvectors symbolically. For each
eigenvalue it's multiplicity and eigenvectors are given in a nested list and matrix structure:
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The Eigenvectors are returned as row vectors. For multiple eigenvalues the vectors are
returned as rows in a matrix.

There is also a numeric procedure for eigenvalue problems: eigens_by_jacobi(). It
returns a list of eigenvalues and the corresponding spectral matrix with it's columns
being the normalized eigenvectors.

The spectral matrix rotates the matrix to diagonal form with the eigenvalues populating
the diagonal
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2.2 Manipulations of Terms

args() extracts the arguments of a function.

An application is the conversion of a matrix into a list of lists (which is sometimes needed
for specifying graphics objects). In Maxima a matrix is represented as the function
matrix([...],[...]...) with the rows represented by lists. args() extracts the rows
of a matrix as a list of lists:

apply(f, list) converts the elements of list into arguments of function f.

A combination of both functions allows to apply the rows of a matrix as arguments of a
function. Some graphics functions like label() take arbitrary numbers of lists as argu-
ments. This is easy to generate from a matrix using the args() and apply() combination:

The function ev() applies substitutions to an expression. This goes beyond the SMath
function at(), because it can replace complex expressions, not just variables:
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2.3 Calculus

Symbolic Derivatives

SMath can handle symbolic derivatives on it's own. Should that fail in particular cases,
you can switch to Maxima. This also enables the prime operator form, which exists
in SMath but is not functional without the Maxima plugin. The function behind this
operator is diff().

Symbolic Integrals

Once the integral functions are taken over, SMath can handle indeterminate integrals
symbolically.

SMath will always try to handle determinate integrals numerically. Only if SMath fails,
the takeover by Maxima will take e�ect. If you want to enforce handling by Maxima, you
can use the capitalized function form Int(f, x, a, b).
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Symbolic Limits

SMath has a native limit operator, yet normally that is not functional. Takeover by
Maxima enables symbolic limits.

Single-sided limits are speci�ed by adding -'0 or +'0 (a zero marked as unit) to the
limit point. Using plus/minus a simple zero was possible in early SMath versions. Yet
now there is no chance for the plugin to prevent SMath preprocessing from removing the
zero. However, marking the zero as unit does the trick.
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The Maxima plugin provides access to Maxima's draw package1. It's back-end is the
�exible and powerful open source graphics software Gnuplot2 . The graphics are saved in
temporary or user-speci�ed �les.

Unique selling points of Maxima graphics:

� Logarithmic plots (which you otherwise would only get with the ZedGraph region,
which is very complicated to handle)

� Shaded 3D plots

There are two options to place Maxima plots on the sheet:

Draw functions and Image region The functions Draw2D() and Draw3D() produce 2D
and 3D plots respectively and return the �le name used for storage. This name
goes to the placeholder of an Image region, a general purpose region for display of
graphics from �les or matrix variables. This region is provided by the Image Region
plugin.

Use this for complete control by graphics commands.

Draw region These are dedicated Maxima plot regions, found under Insert> Max-
ima> Draw2D and Draw3D. They provide a setting menu and some moderate
(slow) interactivity for scaling and rotating plots.

Use this for convenience: Interactive sizing, scaling and rotation and less commands
required.

Both options share the same graphics features. In both cases, the user provides a list of
objects and options to control the plot.

When demonstrating features, we mostly use the Draw2D()/3D() functions, because they
don't have hidden settings.

The graphics can be produced as PNG, SVG or PDF �les.

1riotorto.users.sourceforge.net/Maxima/gnuplot
2www.gnuplot.info
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PNG is fastest but has sometimes visual glitches (incomplete display of characters)

SVG is good for export. Rendering on the canvas su�ers from wrong text alignment in
the image region and noenhanced text mode in the Draw regions. This means that
texts like �a^b� and �c_2� aren't handled correctly.

PDF Best option for high quality display and export.
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3.1 Your First Draw2D() Plot

1. Create an Image region. Insert> Image. A region with a placeholder appears.
The actual size of that region is not important for now.

2. In the placeholder, add the Draw2D() functions with a list of commands as argu-
ment.

Make sure to use the boolean equal for commands like title = �My first plot�

3. Leave the region (click next to it) to see the result. The default image size is 300 x
240 pixels in 2D and 300 x 300 in 3D. Yet the image is scaled to the actual size of
the image region.

4. Adjust the region to match the image size: Context menu (left mouse button)>
Reset to original size.

Plot commands consist of objects and options.

� Global options a�ect the whole scene. Their position in the command list is not
relevant.

� Local options a�ect subsequent objects. They must precede the object they are
supposed to a�ect.

The options have to be written as equations with the boolean equality symbol option=value.

In the Draw-Description snippet (see section 3.3) you �nd comprehensive information on
the available objects and options.

Some of the options are explained in the subsequent sections and demonstrated in the
examples for the graphics objects in chapters 4 and 5.
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3.2 Draw2D() and Draw3D() Functions

The functions Draw2D() and Draw3D() actually produce an image �le and returns it's
name. The image region takes a �le name in the placeholder. This �le is read and
displayed.

You can use additional arguments to specify a �le name and the size of the graphics.

commands List of objects and options.

�lename (default: �pdf�) format and storage location of the graphics �le. If just an
extension is given (�png�, �svg� or �pdf�), then a temporary �le name is generated
in the speci�ed format.

Relative �lenames (without full path speci�cation) are relative to the current direc-
tory. It is advisable to set the current directory to the document directory. This
yields portable documents.

width, height (default 300 x 240 for Draw2D() and 300 x 300 for Draw3D()) size of the
graphics �le in pixels. In the Image region, the graphics is scaled to the size of the
region. Yet to keep consistent font sizes, do it the other way around:

� Specify size as needed in the draw function

� Adjust the region to match the image size: Context menu> Reset to orig-
inal size.
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3.3 The Draw-Descriptions Snippet

Creating graphics with Maxima is all about knowing the available objects and options.
SMath doesn't know these by default, so that the dynamic assistant doesn't help.

The Draw-Descriptions snippet (snippets are collapsible area regions with SMath regions)
contains dummy de�nitions with attached descriptions of all objects and options in Ger-
man and English. Once this snippet is inserted, the dynamic assistant knows them all.

Insert the snippet:

1. Set the cursor to where you want the snippet (it appears just as a thin line)

2. Open the snippets page of the extension manager Tools> Snippet Manager

3. Locate and select the snippet �Draw Descriptions� in the list. If it is not there, you
might need to switch to the online gallery and get it from there.

4. Make sure to select �insert snippet inside Area Region� and press Insert

The dynamic assistant knows about locally stored snippets. So it is easy to insert the
Draw-descriptions using the keyboard:

The snippet is inserted as a collapsed area region:

You can open the area region by clicking the + and browse the available objects and
options. The real comfort of the snippet is that you avoid typos and get reference on
available arguments and options.
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3.4 Axes and Grid

The following images summarize the options for control of the axes and the grid. The
default values are given in blue.
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proportional axes
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xaxis width
xaxis color
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yaxis type
yaxis width
yaxis color

title xtics secondary
xrange secondary
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ytics secondary
yrange secondary
ytics secondary axis
ytics rotate secondary

xtics
xrange
xtics rotate
xtics axis
logx

axis bottom

ytics
yrange
ytics rotate
ytics axis
logy

axis right

y
la
b
el

none

auto
auto

false
false

false

solid
dots

solid
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truetrue
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true false
auto

false
false

false
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false
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y

proportional axes

xlabel

title
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yrange
ytics axis
logy
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false
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ylabel

zlabel

logz
ztics axis
zrange
ztics

axis 3d
xyplane auto

true

grid

x/y/zaxis
x/y/zaxis type
x/y/zaxis width
x/y/zaxis color

dots

xtics
xrange
xtics axis
logx

auto
auto

false

auto
auto

false

false

false

true

view

{
α
β

Angle between direction of view and north pole (+z)

Rotation about z

β = 30◦

α = 60◦
z

x

y

z

false

The grid is active by default for the x and y axes.

Text labels are produced in Gnuplot's enhanced mode with full Unicode support (UTF8):
a_b yields ab, a^b yields ab.

This applies for all types of text:

� Axes labels (xlabel, ylabel, zlabel, xlabel_secondary, ylabel_secondary)

� Title (option title)

� Text labels at arbitrary coordinates (object label()).
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3.5 Point and Line Types

Table 3.1: Examples for line_type and line_width.

Table 3.2: Examples for point_type and point_size.
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3.6 Colors

The color values for the options background_color, color, palette and x/y/zaxis_color
can be speci�ed in di�erent ways:

� String with hexadecimal RGB value "#rrggbb". Each digit (byte) represent a hex-
adecimal number 0-9, a-f. Each two bytes represent decimal integers from 0-255.
"#000000" is black and "#ffffff" is white.

� String with hexadecimal RGBA value "#rrggbbtt". The tt bytes denote trans-
parency 00 is opaque (non-transparent) and ff is full transparency. Note that
SMath native plots use the ARGB color scheme �#ttrrggbb�.

� As color name (string or unde�ned variable name)

Table 3.3: Valid color names. Other colors must be speci�ed as RGB or RGBA hex
strings.
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3.7 Maxima Draw Regions

The Maxima plugin provides dedicated regions for graphics, where the graphics commands
directly go to the placeholder. They are called Draw regions. The advantages of this
approach:

� Mouse control for pan, zoom and rotation of the axes (yet quite slow)

� The size of the generated graphics is adapted to the region size (which you can drag
with the mouse)

� Settings dialog for axes and diagram properties. This reduces the amount of com-
mands required in the input �eld and of lookup work to �nd the proper commands.

Insert> Maxima> Draw2D or Draw3D

As long as the input placeholder is empty, a sample plot is shown (left: Draw2D, right:
Draw3D:

The placeholder takes a list with draw objects and options just as the �rst argument of
the functions Draw2D() and Draw3D() (see section (3.2)).

The context menu also has interesting options:

� (Un)select �Display input data� to hide the graphics commands,

� (Un)select the outer border of the region,

� Export graphics to a �le (this actually just saves the existing temporary �le to a
user-speci�ed location

Mouse Control

Sizing: Drag the control points at the border to resize the image. Upon release, the
graphics is re-computed with a new size. If you want to change the font size, use the
settings dialog.
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Rotating: Drag the image to rotate the plot. Upon release, the graphics is re�computed
with the new orientation.

Scaling (axes limits): Scroll (with the mouse wheel). Scroll: Modi�es the axes limits.

Scroll up reduces the limits (expands the objects), scroll down increases the limits (shrinks
the objects). This acts on axes whith range control set to �Mouse� in the Plot settings
form. By default, just the vertical axis is activated.

Scaling (bounding box): Shift-scroll changes the size of the bounding box in 3D plots
relative to the region size. Ctrl-scroll scales the bounding box vertically. The axes limits
aren't a�ected by these settings.
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3.8 Units in Graphics

SMath internally converts any units to base units before storage. Maxima generally treats
units as symbolic constants. In plot functions, any units are replaced by the number 1.

Thus, any base units in plot expressions are optional.

To use a di�erent unit for the independent variables, multiply them by this unit wherever
they appear in the expression.

To use a di�erent units for the value of an expression, divide it by this unit.

Adjust the axes labels accordingly using the xlabel and ylabel options or the settings
menu of the Draw regions.
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Draw2d3d-EN.sm (takes some time to recalculate)

Here we demonstrate the available objects for 2D graphics, i.e. for use with Draw2D() or
the Draw2D region. For some of the objects, we also explain some of the most important
options. The Draw Description snippet is a good source on available options.
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             :
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             [Maxima Draw]  contour_levels (=5): contour levels. number oder list  (min, Δ, max), or set(L1, L2,...) of values
          
          
           
             contour_levels
             contour_levels
             :
          
        
      
       
         
           
             
             [Maxima Draw]  data_file_name (="data.gnuplot"): Kurvendaten für Gnuplot
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             [Maxima Draw]  delay (=5): time step in animated gif files
          
          
           
             delay
             delay
             :
          
        
      
       
         
           
             
             [Maxima Draw]  dimensions (= 600 x 500): Liste [Breite,Höhe]
          
          
           
             
             [Maxima Draw]  dimensions (= 300 x 240 for 2D, 300 x 300 for 3D) list [width, height]
          
          
           
             dimensions
             dimensions
             :
          
        
      
       
         
           
             
             [Maxima Draw]  draw_realpart (=true) Realteil zur Darstellung komplexer Werte verwenden
          
          
           
             
             [Maxima Draw]  draw_realpart (=true) use real part for plotting complex values
          
          
           
             draw_realpart
             draw_realpart
             :
          
        
      
       
         
           
             
             [Maxima Draw]  enhanced3d (=true) Farbpalette, none: 3D Flächen als Gitter zeichnen   (Steuerung mit color und surface_hide), true: Farbe anhand des z-Werts,  Liste  [f(x,y,z), x, y, z]: Farbe anhand der Funktion f,   Liste [f(u,v),u,v]: Farbe anhand der Flächenparameter oder Liste [f(k), k ]:  Farbe anhand der Punktnummer in points() Objekten
          
          
           
             
             [Maxima Draw]  enhanced3d (=true) don't use color palette, draw 3D surfaces as grid  (control using color und surface_hide), true: coloring of surfaces by z-value,  or  list  [f(x,y,z), x, y, z]: coloring according to function f or  list [f(u,v),u,v]  or list [f(k), k ] (k being the point counter in points() objects)
          
          
           
             enhanced3d
             enhanced3d
             :
          
        
      
       
         
           
             
             [Maxima Draw] error_type (=y) Art der Fehlerbalken in errors():  x, y, xy oder boxes
          
          
           
             
             [Maxima Draw] error_type (=y) type of error bars in errors():  x, y, xy or boxes
          
          
           
             error_type
             error_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] file_name (="maxima_out") Grafik-Ausgabedatei, Endung wird gemäß Ausgabeformat ergänzt
          
          
           
             
             [Maxima Draw] file_name (="maxima_out") output file, extension is set according to format
          
          
           
             file_name
             file_name
             :
          
        
      
       
         
           
             
             [Maxima Draw] fill_color (=red) Füllfarbe für Objejte polygon() und  explicit() in 2D 
          
          
           
             
             [Maxima Draw] fill_color (=red) fill color for polygons and explicit functions y(x) in 2D 
          
          
           
             fill_color
             fill_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] fill_density (=0) Deckungsgrad der Füllfarbe in bars()-Objekten, zwischen 0 und 1
          
          
           
             
             [Maxima Draw] fill_density (=0) opacity of the fill color in bars()-objects, 0..1
          
          
           
             fill_density
             fill_density
             :
          
        
      
       
         
           
             
             [Maxima Draw] filled_func (=false): explizite Funktionen y(x) werden nicht gefüllt, true: Füllung bis zur Unterkante des Diagramms, g(x): Füllung zwischen g(x)  und y(x)
          
          
           
             
             [Maxima Draw] filled_func (=false): don't fill explicit functions y(x), true: fill between the next explicit() object and the bottom border of the diagram, g(x): fill between g(x) and the next explicit() object
          
          
           
             filled_func
             filled_func
             :
          
        
      
       
         
           
             
             [Maxima Draw] gnuplot_file_name (="maxout.gnuplot"): Kommandodatei für Gnuplot
          
          
           
             
             [Maxima Draw] gnuplot_file_name (="maxout.gnuplot"): name of the temporary gnuplot command file
          
          
           
             gnuplot_file_name
             gnuplot_file_name
             :
          
        
      
       
         
           
             
             [Maxima Draw] gnuplot_term (): Ausgabe-Format-Spezifikation (Text nach "set terminal")
          
          
           
             
             [Maxima Draw] gnuplot_term (): gnuplot terminal options (arguments of "set terminal")
          
          
           
             gnuplot_term
             gnuplot_term
             :
          
        
      
       
         
           
             
             [Maxima Draw] gnuplot_out_file (=maxplot.xxx) Ausgabedateiname (xxx abhängig vom Format)
          
          
           
             
             [Maxima Draw] gnuplot_out_file (=maxplot.xxx) output file name (xxx depends on terminal)
          
          
           
             gnuplot_out_file
             gnuplot_out_file
             :
          
        
      
       
         
           
             
             [Maxima Draw] grid (=true): false: kein Gitterraster zeichnen, true: Gitter zeichnen
          
          
           
             
             [Maxima Draw] grid (=true): draw grid, remove grid by user_preamble="unset grid"
          
          
           
             grid
             grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_angle (=45) Pfeilwinkel an vector()-Objekten (halber Öffnungswinkel in °)
          
          
           
             
             [Maxima Draw] head_angle (=45): head angle of vector()-Objekten (angle between border and vector   direction in °)
          
          
           
             head_angle
             head_angle
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_both (=false) oder true: ob bei vector()-Objekten zwei Pfeilspitzen gezeichnet werden.
          
          
           
             
             [Maxima Draw] head_both (=false): don't draw a second head of vector() objects,  true: draw a second head
          
          
           
             head_both
             head_both
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_length (=2) Länge der Pfeilspitze  bei vector()-Objekten in Einheiten der x-Achse
          
          
           
             
             [Maxima Draw] head_length (=2): head length of vector() objects in units of the x-axis
          
          
           
             head_length
             head_length
             :
          
        
      
       
         
           
             
             [Maxima Draw] head_type (=filled) Spitzenform bei vector()-Objekten:  filled, empty  oder nonfilled
          
          
           
             
             [Maxima Draw] head_type (=filled) head type of vector() objects:  filled, empty  or nonfilled
          
          
           
             head_type
             head_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] ip_grid (={50, 50): Primäres Gitter für die Darstellung impliziter Funktionen, als Liste angeben
          
          
           
             
             [Maxima Draw] ip_grid (={50, 50): primary grid for sampling of implicit functions, two-element list
          
          
           
             ip_grid
             ip_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] ip_grid_in (={5, 5 ): Sekundäres Gitter für die Darstellung impliziter Funktionen
          
          
           
             
             [Maxima Draw] ip_grid_in (={5, 5 ): secondary grid for sampling of implicit functions
          
          
           
             ip_grid_in
             ip_grid_in
             :
          
        
      
       
         
           
             
             [Maxima Draw] key (=""): Legendeneintrag für das nachfolgende Grafikobjekt.
          
          
           
             
             [Maxima Draw] key (=""): legend key for subsequent graphics object.
          
          
           
             key
             key
             :
          
        
      
       
         
           
             
             [Maxima Draw] key_pos (="", entspricht top_right): Legendenposition. Gültige Werte: top_left, top_center, top_right,  center_left, center, center_right, bottom_left, bottom_center, bottom_right
          
          
           
             
             [Maxima Draw] key_pos (="", equivalent to top_right): position of the legend. Valid options: top_left, top_center, top_right,  center_left, center, center_right, bottom_left, bottom_center, bottom_right
          
          
           
             key_pos
             key_pos
             :
          
        
      
       
         
           
             
             [Maxima Draw] label_alignment (=center), left oder right: horizontale Ausrichtung von Beschriftungen
          
          
           
             
             [Maxima Draw] label_alignment (=center), left or right: alignment of text labels
          
          
           
             label_alignment
             label_alignment
             :
          
        
      
       
         
           
             
             [Maxima Draw] label_orientation (=horizontal) oder vertical: Ausrichtung von Texten
          
          
           
             
             [Maxima Draw] label_orientation (=horizontal) or vertical: orientation of text labels
          
          
           
             label_orientation
             label_orientation
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_type (=solid) Linienart. Alternativen: dots (für alle Formate) oder wenn von Gnuplot unterstützt: dashes, short_dashes, short_long_dashes, short_short_long_dashes 
          
          
           
             
             [Maxima Draw] line_type (=solid) line type. Other options: dots (for all formats) or if supported by Gnuplot: dashes, short_dashes, short_long_dashes, short_short_long_dashes 
          
          
           
             line_type
             line_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_width (=1) , >0 
          
          
           
             line_width
             line_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] logcb (=false) oder true: logarithmische Farbskale
          
          
           
             
             [Maxima Draw] logcb (=false) or true: log scale of the colorbar
          
          
           
             logcb
             logcb
             :
          
        
      
       
         
           
             
             [Maxima Draw] logx (=false) oder true: logarithmische x-Achse
          
          
           
             
             [Maxima Draw] logx (=false) or true: log scale of x-axis
          
          
           
             logx
             logx
             :
          
        
      
       
         
           
             
             [Maxima Draw] logx_secondary (=false) oder true: logarithmische zweite x-Achse
          
          
           
             
             [Maxima Draw] logx_secondary (=false) or true: log scale of secondary x-axis
          
          
           
             logx_secondary
             logx_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logy (=false) oder true: logarithmische y-Achse
          
          
           
             
             [Maxima Draw] logy (=false) or true: log scale of y-axis
          
          
           
             logy
             logy
             :
          
        
      
       
         
           
             
             [Maxima Draw] logy_secondary (=false) oder true: logarithmische zweite y-Achse
          
          
           
             
             [Maxima Draw] logy_secondary (=false) or true: log scale of secondary y-axis
          
          
           
             logy_secondary
             logy_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logz (=false) oder true: logarithmische z-Achse
          
          
           
             
             [Maxima Draw] logz (=false) or true: log scale of z-axis
          
          
           
             logz
             logz
             :
          
        
      
       
         
           
             
             [Maxima Draw] nticks (=29): Punktezahl für die Kurvenabtastung
          
          
           
             
             [Maxima Draw] nticks (=29): number of points for curve sampling (explicit and parametric)
          
          
           
             nticks
             nticks
             :
          
        
      
       
         
           
             
             [Maxima Draw] palette (=[violet, blue, green, yellow, re]) color: Standard-Farbpalette, gray: Graustufen, Liste [ Farbe1, Farbe2... ] oder false: Flächen nicht färben 
          
          
           
             
             [Maxima Draw] palette (=[violet, blue, green, yellow, red]) color palette, color: standard color palette (black, violet, red, yellow), gray: gray levels, list  [color1, color2... ] or false: don't color 3D objects 
          
          
           
             palette
             palette
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_size (=1) Größe von points()-Symbolen
          
          
           
             
             [Maxima Draw] point_size (=1) size of points()-symbols
          
          
           
             point_size
             point_size
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_type (=1) Symbol für points()-Objekte, Name oder Kennzahl:  none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5,  circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10,  filled_dwn_triangle 11, diamant 12, filled_diamant 13
          
          
           
             
             [Maxima Draw] point_type (=1) type of points() objects, name or key number: none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5,  circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10,  filled_down_triangle 11, diamant 12, filled_diamant 13
          
          
           
             point_type
             point_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] points_joined (=false), true oder impulses: Verbindungsart von points()-Objekten
          
          
           
             
             [Maxima Draw] points_joined (=false), true or impulses: how to join points
          
          
           
             points_joined
             points_joined
             :
          
        
      
       
         
           
             
             [Maxima Draw] proportional_axes (=none), xy oder xyz: Achsen mit gleicher Skalierung)
          
          
           
             
             [Maxima Draw] proportional_axes (=none), xy or xyz: set axes of equal scaling)
          
          
           
             proportional_axes
             proportional_axes
             :
          
        
      
       
         
           
             
             [Maxima Draw] surface_hide (=false) oder true: Ausblendung verdeckter Flächen bei Linienrasterdarstellung
          
          
           
             
             [Maxima Draw] surface_hide (=false) or true: handling of hidden lines in surface grids
          
          
           
             surface_hide
             surface_hide
             :
          
        
      
       
         
           
             
             [Maxima Draw] terminal (=screen) separate interactive terminal window,  png, jpg, gif, eps, svg, pdf,  animated_gif: gnuplot output format
          
          
           
             terminal
             terminal
             :
          
        
      
       
         
           
             
             [Maxima Draw] title (="") Überschrift für das Diagramm
          
          
           
             
             [Maxima Draw] title (="") headline for the plot
          
          
           
             title
             title
             :
          
        
      
       
         
           
             
             [Maxima Draw] transform (=none) Koordinatentransformation, für 2D als Liste {f1(x,y), f2(x,y), x, y, für 3D als Liste {f1(x,y), f2(x,y), f3(x, y, z), x, y, z
          
          
           
             
             [Maxima Draw] transform (=none) co-ordinate transformation, for 2D as list {f1(x,y), f2(x,y), x, y, for 3D as list {f1(x,y), f2(x,y), f3(x, y, z), x, y, z
          
          
           
             transform
             transform
             :
          
        
      
       
         
           
             
             [Maxima Draw] transparent (=false) oder true: ob Rechtecke, Polygone oder Ellipsen transparent sein sollen  (bei false werden sie gefüllt)
          
          
           
             
             [Maxima Draw] transparent (=false) fill objects with border, true: don't fill (make them transparent)
          
          
           
             transparent
             transparent
             :
          
        
      
       
         
           
             
             [Maxima Draw] unit_vectors (=false) oder true: Vektoren in originaler Länge oder als Einheitsvektoren zeichnen.
          
          
           
             
             [Maxima Draw] unit_vectors (=false) draw vectors in original length, true: draw unit vectors.
          
          
           
             unit_vectors
             unit_vectors
             :
          
        
      
       
         
           
             
             [Maxima Draw] user_preamble (="") Zeichenkette oder Liste von Zeichenketten, die unmittelbar vor dem eigentlichen  Diagrammbefehl an Gnuplot übergeben werden.
          
          
           
             
             [Maxima Draw] user_preamble (="") string or list of strings, gnuplot commands placed  immediately before the plot commands
          
          
           
             user_preamble
             user_preamble
             :
          
        
      
       
         
           
             
             [Maxima Draw] view (=(60,30)) view direction
          
          
           
             view
             view
             :
          
        
      
       
         
           
             
             [Maxima Draw] wired_surface (=false) oder true: Gitternetz auf eingefärbten Flächen anzeigen oder nicht.
          
          
           
             
             [Maxima Draw] wired_surface (=false) no grid on colored surfaces, true: draw grid on surfaces
          
          
           
             wired_surface
             wired_surface
             :
          
        
      
       
         
           
             
             [Maxima Draw] x_voxel (=10) x-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen
          
          
           
             
             [Maxima Draw] x_voxel (=10) number of x steps for the Marching Cube algorithm (for implicit 3D functions)
          
          
           
             x_voxel
             x_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] y_voxel (=10) y-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen
          
          
           
             
             [Maxima Draw] y_voxel (=10) number of y steps for the Marching Cube algorithm (for implicit 3D functions)
          
          
           
             y_voxel
             y_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] z_voxel (=10) z-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen
          
          
           
             
             [Maxima Draw] z_voxel (=10) number of z steps for the Marching Cube algorithm (for implicit 3D functions)
          
          
           
             z_voxel
             z_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis (=true) oder false: Anzeige der x-Achse
          
          
           
             
             [Maxima Draw] xaxis (=true) false: don't draw x-axis or true: draw x-axis
          
          
           
             xaxis
             xaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis (=true) oder false: Anzeige der y-Achse
          
          
           
             
             [Maxima Draw] yaxis (=true) false: don't draw x-axis or true: draw y-axis
          
          
           
             yaxis
             yaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis (=true) oder false: Anzeige der z-Achse
          
          
           
             
             [Maxima Draw] zaxis (=false) or true: draw z-axis
          
          
           
             zaxis
             zaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_color (=black) Farbe x-Achse
          
          
           
             
             [Maxima Draw] xaxis_color (=black) color of the x-axis
          
          
           
             xaxis_color
             xaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_color (=black) Farbe y-Achse
          
          
           
             
             [Maxima Draw] yaxis_color (=black) color of the y-axis
          
          
           
             yaxis_color
             yaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis_color (=black) Farbe z-Achse
          
          
           
             
             [Maxima Draw] zaxis_color (=black) color of the z-axis
          
          
           
             zaxis_color
             zaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_secondary (=false) oder true: Nutzung einer zweiten x-Achse (oben) für die nachfolgenden Objekte
          
          
           
             
             [Maxima Draw] xaxis_secondary (=false) or true: use the secondary x-axis (top) for subsequent objects
          
          
           
             xaxis_secondary
             xaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_secondary (=false) oder true: Nutzung einer zweiten y-Achse (rechts) für die nachfolgenden Objekte
          
          
           
             
             [Maxima Draw] yaxis_secondary (=false) or true: use the secondary y-axis (right) for subsequent objects
          
          
           
             yaxis_secondary
             yaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_type (=solid) oder dots: Linienart der x-Achse
          
          
           
             
             [Maxima Draw] xaxis_type (=solid) or dots
          
          
           
             xaxis_type
             xaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_type (=solid) oder dots: Linienart der y-Achse
          
          
           
             
             [Maxima Draw] yaxis_type (=solid) or dots
          
          
           
             yaxis_type
             yaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis_type (=dots) oder solid: Linienart der z-Achse
          
          
           
             
             [Maxima Draw] zaxis_type (=dots) or solid
          
          
           
             zaxis_type
             zaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_width (=1) Linienbreite der x-Achse
          
          
           
             
             [Maxima Draw] xaxis_width (=1)
          
          
           
             xaxis_width
             xaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_width (=1) Linienbreite der y-Achse
          
          
           
             
             [Maxima Draw] yaxis_width (=1)
          
          
           
             yaxis_width
             yaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] zaxis_width (=1) Linienbreite der z-Achse
          
          
           
             
             [Maxima Draw] zaxis_width (=1)
          
          
           
             zaxis_width
             zaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel (="") x-Achsenbeschriftung
          
          
           
             
             [Maxima Draw] xlabel (="x") label of the x-axis, remove using ""
          
          
           
             xlabel
             xlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel(="") y-Achsenbeschriftung
          
          
           
             
             [Maxima Draw] ylabel (="y") label of the y-axis, remove using ""
          
          
           
             ylabel
             ylabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] zlabel (="") z-Achsenbeschriftung
          
          
           
             
             [Maxima Draw] zlabel (="") label of the z-axis
          
          
           
             zlabel
             zlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel_secondary (="") Beschriftung der zweiten x-Achse
          
          
           
             
             [Maxima Draw] xlabel_secondary (="") label of the secondary x-axis
          
          
           
             xlabel_secondary
             xlabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel_secondary (="") Beschriftung der zweiten y-Achse
          
          
           
             
             [Maxima Draw] ylabel_secondary (="") label of the secondary y-axis
          
          
           
             ylabel_secondary
             ylabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange (=auto) oder Liste {min,max: x-Achsenbereich
          
          
           
             
             [Maxima Draw] xrange (=auto) or list {min,max: range of the x-axis
          
          
           
             xrange
             xrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange (=auto) oder Liste {min,max: y-Achsenbereich
          
          
           
             
             [Maxima Draw] yrange (=auto) or list {min,max: range of the y-axis
          
          
           
             yrange
             yrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] zrange (=auto) oder Liste {min,max: z-Achsenbereich
          
          
           
             
             [Maxima Draw] zrange (=auto) or list {min,max: range of the z-axis
          
          
           
             zrange
             zrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange_secondary (=auto) oder Liste {min,max: Bereich der zweiten (oberen) x-Achse
          
          
           
             
             [Maxima Draw] xrange_secondary (=auto) or list {min,max: range of the secondary (top) x-axis
          
          
           
             xrange_secondary
             xrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange_secondary (=auto) oder Liste {min,max: Bereich der zweiten (rechten) y-Achse
          
          
           
             
             [Maxima Draw] yrange_secondary (=auto) or list {min,max: range of the secondary (right) y-axis
          
          
           
             yrange_secondary
             yrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics (=auto): automatische x-Achsmarken, none: keine, Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen ("text",pos) mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] xtics (=auto): automatic x ticks, none: no x ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             xtics
             xtics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics (=auto): automatische y-Achsmarken, none: keine, Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] ytics (=auto): automatic y ticks, none: no y ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             ytics
             ytics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics (=auto): automatische z-Achsmarken, none: keine, Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] ztics (=auto): automatic z ticks, none: no x ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             ztics
             ztics
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary (=auto): automatische Marken an der sekundären (oberen) x-Achse, none: keine,  Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] xtics_secondary (=auto): automatic ticks on the secondary (top) x-axis, none: no ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             xtics_secondary
             xtics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary (=auto): automatische Marken an der sekundären (rechten) y-Achse, none: keine,  Zahl: Schrittweite,  Liste mit {min, Schritt, max, oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set()  von Listen {"text",pos mit Vorgabe von Beschriftung und Position.
          
          
           
             
             [Maxima Draw] ytics_secondary (=auto): automatic ticks on the secondary (right) y-axis, none: no ticks, number: tick interval,   list of {min, step, max, or set() of numbers: explicit tick values, or set() of lists ("text",pos) for spec of position and text.
          
          
           
             ytics_secondary
             ytics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_axis (=false): x-Achsmarken am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] xtics_axis (=false): ticks on the boundary, true: ticks on the axis
          
          
           
             xtics_axis
             xtics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_axis (=false): y-Achsmarken am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] ytics_axis (=false): ticks on the boundary, true: ticks on the axis
          
          
           
             ytics_axis
             ytics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_axis (=false): z-Achsmarken am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] ztics_axis (=false): ticks on the boundary, true: ticks on the axis
          
          
           
             ztics_axis
             ztics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary_axis (=false): Marken an der sekundaren (oberen) x-Achse am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] xtics_secondary_axis (=false): ticks on the secondary (top) boundary, true: ticks on the axis
          
          
           
             xtics_secondary_axis
             xtics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary_axis (=false): Marken an der sekundaren (rechten) y-Achse am Rand, true: an der Achse
          
          
           
             
             [Maxima Draw] ytics_secondary_axis (=false): ticks on the secondary (right) boundary, true: ticks on the axis
          
          
           
             ytics_secondary_axis
             ytics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate (=false): x-Achsmarken nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] xtics_rotate (=false): horizontal tick labels, true: vertical tick labels
          
          
           
             xtics_rotate
             xtics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate (=false): y-Achsmarken nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] ytics_rotate (=false): horizontal tick labels, true: vertical tick labels
          
          
           
             ytics_rotate
             ytics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_rotate (=false): z-Achsmarken nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] ztics_rotate (=false): horizontal tick labels, true: vertical tick labels
          
          
           
             ztics_rotate
             ztics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): Marken an der sekundären (oberen) x-Achse nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): don't rotate ticks of the secondary (top) x-axis, true: rotate about 90°
          
          
           
             xtics_rotate_secondary
             xtics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): Marken an der sekundären (rechten) y-Achse nicht drehen, true: um 90° drehen
          
          
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): don't rotate ticks of the secondary (right) y-axis, true: rotate about 90°
          
          
           
             ytics_rotate_secondary
             ytics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xu_grid (=30) Abtastpunkte in x- oder u-Richtung 
          
          
           
             
             [Maxima Draw] xu_grid (=30) sampling points in x- or u-direction 
          
          
           
             xu_grid
             xu_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] yv_grid (=30) Abtastpunkte in y- oder v-Richtung 
          
          
           
             
             [Maxima Draw] yv_grid (=30) sampling points in y- or v-direction 
          
          
           
             yv_grid
             yv_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw]  xyplane (=false):  xy-Koordinatenebene automatisch anordnen, Zahl: z-Koordinate
          
          
           
             
             [Maxima Draw3D]  xyplane (=false):  automatic allocation of the xy-plane, reak number: xy-plane intersects the z-axis at this level
          
          
           
             xyplane
             xyplane
             :
          
        
      
       
         
           
           Objekte 
        
        
      
       
         
           
             
             [Maxima Draw2D] bars(b1,b2...) Säulendiagramm, Säulen gegeben durch Listen (x,h,w). Optionen: key, color, fill_color, fill_density and line_
          
          
           
             
             [Maxima Draw2D] bars(b1,b2...) vertical bars, given as lists (x,h,w). Options: key, color, fill_color, fill_density and line_width
          
          
           
             _
             bars
             _
             bars
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Stellt eine Matrix in 3D dar. M_11 bei x=x0,y=y0+h, M_mn bei x=x0+w,y=y0. Optionem:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Draws a m x n-matrix in 3D. M_11 at x=x0,y=y0+h, M_mn at x=x0+w,y=y0. Options:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             _1
             _2
             _3
             _4
             _5
             elevation_grid
             _1
             _2
             _3
             _4
             _5
             elevation_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,φ2) Ellipse, zentriert bei xc, yc mit den Halbachsen a und b, von Winkel φ1 bis  Winkel φ2. Optionen nticks, transparent, fill_color, border, line_width, line_type, key and color. 
          
          
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,φ2) plots an ellipse centered at [xc, yc] with horizontal and vertical semi axis a and b, respectively,  starting at angle ang1 with an amplitude equal to angle ang2. Options: nticks, transparent, fill_color, border, line_width, line_type, key and color. 
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             ellipse
             #1
             #2
             #3
             #4
             #5
             #6
             ellipse
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] errors(e1,e2...) Punkte mit Fehlerbalken, horizontal, vertical oder beide, abhängig von der Option error_type.  Argumente für error_type = x: Listen [x, y, xdelta] oder [x, y, xlow, xhigh]. Argumente für error_type = y; Listen [x, y, ydelta] oder [x, y, ylow, yhigh].  Argumente für error_type = xy oder error_type = boxes: Listen [x, y, xdelta, ydelta] oder [x, y, xlow, xhigh, ylow, yhigh].   Optionen: error_type, points_joined, line_width, key, line_type, color, fill_density, xaxis_secondary, and yaxis_secondary 
          
          
           
             
             [Maxima Draw2D] errors(e1,e2...) Draws points with error bars, horizontally, vertically or both, depending on the value of option error_type.  If error_type = x, arguments are lists [x, y, xdelta] or [x, y, xlow, xhigh]. If error_type = y, arguments are lists [x, y, ydelta] or [x, y, ylow, yhigh].  If error_type = xy or error_type = boxes, arguments are lists [x, y, xdelta, ydelta] or [x, y, xlow, xhigh, ylow, yhigh].   Options: error_type, points_joined, line_width, key, line_type, color, fill_density, xaxis_secondary, and yaxis_secondary
          
          
           
             _
             errors
             _
             errors
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) zeichnet eine Funktion f von x von xmin bis xmax.  Optionen: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color und color
          
          
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) plots explicit function f, with variable x taking values from xmin to xmax.  Options: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color and color
          
          
           
             _1
             _2
             _3
             _4
             explicit
             _1
             _2
             _3
             _4
             explicit
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) zeichnet eine Funktion f von x und y im Bereich xmin bis xmax und ymin bis ymax  Optionen: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d und color. 
          
          
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) plots the explicit function f, with variable x taking values from xmin to xmax and variable y  taking values from yminto ymax. Options: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, and color. 
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             explicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             explicit
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] image(Matrix,x0,y0,w,h)  Farbdarstellung einer m x n Matrix entsprechend der Option palette
          
          
           
             
             [Maxima Draw2D] image(matrix,x0,y0,w,h)  plots matrix in the rectangular region from vertex (x0,y0) to (x0+w,y0+h) according to option palette.
          
          
           
             #1
             #2
             #3
             #4
             #5
             image
             #1
             #2
             #3
             #4
             #5
             image
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax)  2D Darstellung einer implizit gegebenen Funktion im angegebenen Variablenbereich  (marching squares Algorithmus). Optionen: ip_grid, ip_grid_in, line_width,  line_type, key, color
          
          
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax) plots the implicit function defined by f,  with variable x taking values from xmin to xmax, and variable y taking values from ymin to ymax. Options: ip_grid, ip_grid_in, line_width,  line_type, key, color
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             implicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             implicit
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax)  3D Darstellung einer implizit gegebenen Funktion im  angegebenen Variablenbereich (Marching Cubes Algorithmus). Optionen: x_voxel, y_voxel, z_voxel,   ip_grid_in, line_width, line_type, wired_surface, enhanced3D, color [Maxima Draw]
          
          
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax) plots the implicit surface defined by f,  with variable x taking values from xmin to xmax, variable y taking values from ymin to ymax and variable z taking values from zmin to zmax.  This object implements the marching cubes algorithm. Options: x_voxel, y_voxel, z_voxel, line_width, line_type, key, wired_surface, enhanced3d,and color
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             #8
             #9
             #10
             implicit
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             #8
             #9
             #10
             implicit
             :
          
        
      
       
         
           
             
             [Maxima Draw2D and 3D] label(list) Beschriftung, im 2D gegeben als Liste (text,x,y), im 3D als Liste (text,x,y,z), spezielle Optionen: color, label_alignment, label_orientation
          
          
           
             
             [Maxima Draw2D and 3D] label(list) text label  specified in 2D as list [text,x,y], in 3D as list [text,x,y,z], Options: color, label_alignment, label_orientation
          
          
           
             _
             label
             _
             label
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) parametrisch gegebenen Funktion. Optionen:  nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) plots the parametric function fx, fy  with parameter p taking values from pmin to pmax. Options  nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             #1
             #2
             #3
             #4
             #5
             parametric
             #1
             #2
             #3
             #4
             #5
             parametric
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] parametric(fx,fy,fz,p,pmin,pmax) parametrisch gegebene Kurve. Optionen:  nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             parametric
             #1
             #2
             #3
             #4
             #5
             #6
             parametric
             :
          
        
      
       
         
           
             
             points(matrix) Punkte, zeilenweise gegeben als n x 2 (2D) oder  n x 3 (3D)-Matrix. Spezielle Optionen: points_joined, point_type, point_size [Maxima Draw2D/3D] 
          
          
           
             
             [Maxima Draw2D and 3D] points(matrix) 2D: n x 2, 3D: n x 3, plots points, given as the rows in a matrix. special options: points_joined, point_type, point_size
          
          
           
             #1
             points
             #1
             points
             :
          
        
      
       
         
           
             
             points(vx,vy) Punkte, gegeben durch Vektoren der x- und y-Koordinaten.  Spezielle Optionen: points_joined, point_type, point_size [Maxima Draw2D] 
          
          
           
             
             [Maxima Draw2D] points(vx,vy) points given by two vectors, special options: points_joined,  point_type, point_size
          
          
           
             #1
             #2
             points
             #1
             #2
             points
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] points(vx,vy,vz) zeichnet Punkte, gegeben durch drei Vektoren, spezielle Optionen: points_joined,  point_type, point_size
          
          
           
             
             [Maxima Draw3D] points(vx,vy,vz) points given by three vectors, special options: points_joined,  point_type, point_size
          
          
           
             #1
             #2
             #3
             points
             #1
             #2
             #3
             points
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] polar(r,φ,φmin,φmax) zeichnet Funktionen, die in Polarkoordinaten gegeben sind (Radius r als Funktion des Winkels φ). Spezielle Optionen: key, nticks, line_width, line_type, color
          
          
           
             
             [Maxima Draw2D] polar(r,φ,φmin,φmax) draws functions given in polar co-ordinates  (radius r as function of angle φ). Special options: key, nticks, line_width, line_type, color
          
          
           
             #1
             #2
             #3
             #4
             polar
             #1
             #2
             #3
             #4
             polar
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] polygon(matrix)  Polygon durch die als n x 2 Matrix gegebenen Punkte. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             
             [Maxima Draw2D] polygon(matrix)  polygon defined by matrix (each row one point). Special options: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             #1
             polygon
             #1
             polygon
             :
          
        
      
       
         
           
             
             [Maxima Draw2D]  polygon(vx,vy)  Zeichnet ein Polygon durch die als x- und y-Vektoren gegebenen Punkte. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             
             [Maxima Draw2D]  polygon(vx,vy)  polygon defined by two vectors. Special options:  transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             #1
             #2
             polygon
             #1
             #2
             polygon
             :
          
        
      
       
         
           
             
             [Maxima Draw2D/3D] quadrilateral(l1,l2,l3,l4)  Viereck, gegeben durch Listen der Eckkoordinaten 2D: (x,y) oder  3D: (x,y,z). Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color,  enhanced3D (nur 3D)
          
          
           
             
             [Maxima Draw2D/3D] quadrilateral(l1,l2,l3,l4)  quadrilateral given by lists  of vertex coordinates: [x,y] in 2D or [x,y,z] in 3D. Special options: transparent, fill_color, border, line_width, key, line_type, color, enhanced3D (3D only)
          
          
           
             #1
             #2
             #3
             #4
             quadrilateral
             #1
             #2
             #3
             #4
             quadrilateral
             :
          
        
      
       
         
           
             
             [Maxima Draw2D]  rectangle(l1,l2)  Rechteck gegeben durch Koordinatenlisten (x,y) gegenüberliegender Ecken. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             
             [Maxima Draw2D]  rectangle(l1,l2)  specified by lists (x,y) of opposite corners. Special options: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             #1
             #2
             rectangle
             #1
             #2
             rectangle
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Füllt das Gebiet wo expr wahr (true) ist im Bereich von xmin, xmax, ymin, ymax. Optionen: fill_color, key, x_voxel, y_voxel
          
          
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Fills the region where expr is true in the domain given by xmin, xmax, ymin, ymax. Options: fill_color, key, x_voxel, y_voxel
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             region
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             region
             :
          
        
      
       
         
           
           spherical() funktioniert nicht
        
        
      
       
         
           
             
             [Maxima Draw2D/3D] triangle(l1,l2,l3)  Dreieck, gegeben durch Koordinatenlisten (x,y) (2D) oder (x,y,z) (3D) der Ecken. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             
             [Maxima Draw2D/3D] triangle(l1,l2,l3)  given by co-ordinate lists (x,y) (2D) or (x,y,z) (3D) of the corners Special options: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             #1
             #2
             #3
             triangle
             #1
             #2
             #3
             triangle
             :
          
        
      
       
         
           
             
             [Maxima Draw3D]  tube(fx,fy,fz,fr,p,pmin,pmax)  Röhre, gegeben durch Mittellinie mit fx,fy,fz und den Radius fr als Funktionen des Parameters p. Spezielle Optionen:  xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d,  color, capping.
          
          
           
             
             [Maxima Draw3D]  tube(fx,fy,fz,fr,p,pmin,pmax)  tube, given by functions fx,fy,fz of the centerline and radius function fr pf parameters p. Special options:  xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d,  color, capping.
          
          
           
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             tube
             #1
             #2
             #3
             #4
             #5
             #6
             #7
             tube
             :
          
        
      
       
         
           
             
             [Maxima Draw2D/3D]  vector(l1,l2)  Pfeil,  gegeben durch Koordinatenlisten (x,y) (2D) oder (x,y,z) (3D) der Endpunkte. Spezielle Optionen:  head_both, head_length, head_angle, head_type, line_width, line_type, key  color.
          
          
           
             
             [Maxima Draw2D/3D]  vector(l1,l2)  given by co-ordinate lists (x,y) (2D) or (x,y,z) (3D) of the end points. Spezielle Optionen:  head_both, head_length, head_angle, head_type, line_width, line_type, key  color.
          
          
           
             #1
             #2
             vector
             #1
             #2
             vector
             :
          
        
      
       
         
           
             
             [Maxima]  set(e1, e2,...) Maxima set (Liste in geschweiften Klammern)
          
          
           
             
             [Maxima]  set(e1, e2,...) Maxima set (in Maxima this is a list in curly braces)
          
          
           
             _
             set
             _
             set
             :
          
        
      
       
         
           
             
             [Maxima] args(expr) Liste der Argumente von expr 
          
          
           
             
             [Maxima] args(expr) list of the top level arguments of expr
          
          
           
             _
             args
             _
             args
             :
          
        
      
       
         
           
           Sonstige
        
        
      
       
         
           
             
             [Maxima] 
          
          
           
             true
             true
             :
          
        
      
       
         
           
             
             [Maxima] 
          
          
           
             false
             false
             :
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           -
           parametric_surface
           6
           1
           sys
           :
        
      
    
     
       
         
           fz
           a
           v
           2
           /
           tan
           ln
           *
           2
           v
           cos
           *
           1
           u
           2
           ^
           v
           sin
           (
           2
           ^
           *
           +
           /
           +
           :
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           400
           300
           2
           1
           sys
           Draw3D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           fx
           u
           2
           /
           u
           cos
           *
           v
           cos
           1
           +
           (
           *
           :
        
      
    
     
       
         
           fy
           u
           2
           /
           u
           sin
           *
           v
           cos
           1
           +
           (
           *
           :
        
      
    
     
       
         
           fz
           u
           v
           sin
           *
           u
           3
           +
           8
           /
           π
           *
           (
           2
           ^
           -
           20
           -
           :
        
      
    
     
       
         
           obj
           user_preamble
           set view 100, 320, 1, 1.5
           1
           1
           sys
           ≡
           xu_grid
           150
           ≡
           yv_grid
           25
           ≡
           fx
           fy
           fz
           u
           0
           13
           π
           *
           v
           π
           -
           π
           parametric_surface
           xyplane
           0
           ≡
           5
           1
           sys
           :
        
      
    
     
       
         
           #
           MaximaLog
        
         
           Received Bytes: 45
(%i87) draw3d([terminal=pdfcairo, file_name=$C:\\Users\\kraska\\AppData\\Roaming\\SMath\\extensions\\plugins\\44011c1e-5d0d-4533-8e68-e32b5badce41\\GnuPlot\\Xf2kJLLw$, font=$Arial$, font_size=14, background_color=$#fefefe$, enhanced3d=true, xlabel=$x$, ylabel=$y$, zlabel=$z$,user_preamble=[$set term pdfcairo enhanced size 10.42, 7.29$, $set encoding utf8$, $set pm3d lighting depthorder base$, $set style line 100 lc rgb 'grey' lt -1 lw 0.1$, $set grid xtics ls 100$, $set grid ytics ls 100$, $set style fill transparent solid 0.45 border$, $set view 120, 357, 1.75, 1.0$],axis_3d=false,colorbox=false,xu_grid=51,yv_grid=51,xtics=none,ytics=none,ztics=none,wired_surface=true,color=black,parametric_surface((2*(u*sin(u)+cos(u))*sin(v))/(1+u^2*(sin(v))^2),(2*(-u*cos(u)+sin(u))*sin(v))/(1+u^2*(sin(v))^2),(2*cos(v)+log(tan(v/2))*(1+u^2*(sin(v))^2))/(1+u^2*(sin(v))^2),u,-9/2,9/2,v,1/20,(-1+20*%pi)/20)]);
(%o87) [gr3d(parametric,parametric)]
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           Draw3D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           line_width
           2
           ≡
           fill_color
           #ffff0088
           ≡
           polygon
           2
           2
           5
           4
           1
           2
           1
           0
           2
           4
           mat
           args
           apply
           fill_color
           #ff000088
           ≡
           3
           2
           7
           2
           6
           4
           5
           5
           4
           2
           mat
           args
           polygon
           proportional_axes
           xy
           ≡
           6
           1
           sys
           :
        
      
    
     
       
         
           obj
           200
           200
           2
           1
           sys
           Draw2D
        
      
    
     
       
         
           polygon
           2
           2
           5
           4
           1
           2
           1
           0
           2
           4
           mat
           args
           apply
           Maxima
        
         
           2
           2
           5
           4
           4
           1
           sys
           1
           2
           1
           0
           4
           1
           sys
           polygon
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           3
           2
           7
           2
           6
           4
           5
           5
           4
           2
           mat
           args
           polygon
           Maxima
        
         
           3
           2
           2
           1
           sys
           7
           2
           2
           1
           sys
           6
           4
           2
           1
           sys
           5
           5
           2
           1
           sys
           4
           1
           sys
           polygon
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           0
           1
           -
           2
           1
           sys
           1
           0
           2
           1
           sys
           0
           1
           2
           1
           sys
           1
           -
           0
           2
           1
           sys
           quadrilateral
           proportional_axes
           xy
           ≡
           xlabel
           
           ≡
           ylabel
           
           ≡
           4
           1
           sys
           :
        
      
    
     
       
         
           obj
           150
           150
           2
           1
           sys
           Draw2D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           0
           0
           2
           1
           sys
           1
           1
           2
           1
           sys
           rectangle
           proportional_axes
           xy
           ≡
           xlabel
           
           ≡
           ylabel
           
           ≡
           xrange
           1
           -
           2
           2
           1
           sys
           ≡
           yrange
           1
           -
           2
           2
           1
           sys
           ≡
           xtics
           1
           ≡
           7
           1
           sys
           :
        
      
    
     
       
         
           obj
           150
           150
           2
           1
           sys
           Draw2D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           cm
           palette
           lightblue
           lightblue
           2
           1
           sys
           ≡
           0
           0
           0
           3
           1
           sys
           1
           0
           2
           3
           1
           sys
           0
           1
           2
           3
           1
           sys
           1
           1
           0
           3
           1
           sys
           quadrilateral
           xyplane
           0
           ≡
           interpolate_color
           true
           ≡
           colorbox
           false
           ≡
           view
           70
           110
           2
           1
           sys
           ≡
           xtics
           0.5
           ≡
           ytics
           0.5
           ≡
           8
           1
           sys
           :
        
      
    
     
       
         
           cm
           200
           200
           2
           1
           sys
           Draw3D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           cm
           line_width
           3
           ≡
           line_type
           short_long_dashes
           ≡
           fill_color
           red
           ≡
           2
           -
           2
           -
           2
           1
           sys
           7
           1
           -
           2
           1
           sys
           rectangle
           transparent
           true
           ≡
           line_type
           solid
           ≡
           line_width
           1
           ≡
           9
           6
           2
           1
           sys
           2
           1.5
           -
           2
           1
           sys
           rectangle
           xrange
           3
           -
           10
           2
           1
           sys
           ≡
           yrange
           3
           -
           6.5
           2
           1
           sys
           ≡
           proportional_axes
           xy
           ≡
           11
           1
           sys
           :
        
      
    
     
       
         
           cm
           Draw2D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           R
           x
           2
           ^
           y
           2
           ^
           +
           (
           1
           4
           /
           1
           ltlt
           (
           :
        
      
    
     
       
         
           obj
           x_voxel
           30
           ≡
           y_voxel
           30
           ≡
           R
           x
           3
           2
           /
           -
           3
           2
           /
           y
           3
           2
           /
           -
           3
           2
           /
           region
           proportional_axes
           xy
           ≡
           4
           1
           sys
           :
        
      
    
     
       
         
           obj
           200
           200
           2
           1
           sys
           Draw2D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           cmds
           user_preamble
           set view 60, 30, 1.0, 1.2
           1
           1
           sys
           ≡
           1
           azi
           0
           2
           π
           *
           zen
           0
           π
           spherical
           proportional_axes
           xyz
           ≡
           xtics
           0.5
           ≡
           ytics
           0.5
           ≡
           xyplane
           1
           -
           ≡
           6
           1
           sys
           :
        
      
    
     
       
         
           cmds
           Draw3D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           p
           fill_color
           #0000ff88
           ≡
           1
           1
           2
           1
           sys
           2
           2
           2
           1
           sys
           3
           0
           2
           1
           sys
           triangle
           proportional_axes
           xy
           ≡
           border
           false
           ≡
           1
           0
           2
           1
           sys
           1
           2
           2
           1
           sys
           2
           0
           2
           1
           sys
           triangle
           5
           1
           sys
           200
           200
           2
           1
           sys
           Draw2D
           :
        
      
    
     
       
         
           p
        
      
    
     
       
         
           p
           interpolate_color
           true
           ≡
           0
           0
           0
           3
           1
           sys
           1
           0
           0
           3
           1
           sys
           0
           1
           1
           3
           1
           sys
           triangle
           1
           0
           0
           3
           1
           sys
           1
           1
           0
           3
           1
           sys
           0
           1
           1
           3
           1
           sys
           triangle
           proportional_axes
           xyz
           ≡
           4
           1
           sys
           200
           200
           2
           1
           sys
           Draw3D
           :
        
      
    
     
       
         
           p
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           a
           2.5
           :
        
      
    
     
       
         
           b
           1.5
           :
        
      
    
     
       
         
           c
           2
           :
        
      
    
     
       
         
           d
           3
           :
        
      
    
     
       
         
           bottle
           color
           blue
           ≡
           0
           0
           a
           -
           (
           t
           sin
           *
           a
           b
           t
           cos
           *
           +
           t
           0
           π
           2
           /
           tube
           0
           0
           a
           -
           (
           t
           sin
           *
           a
           b
           t
           cos
           *
           +
           t
           π
           2
           /
           π
           tube
           color
           red
           ≡
           0
           0
           d
           t
           *
           a
           b
           t
           cos
           *
           +
           t
           0
           π
           tube
           color
           forest_green
           ≡
           c
           c
           t
           cos
           *
           -
           0
           d
           t
           *
           a
           b
           -
           t
           0
           π
           tube
           color
           magenta
           ≡
           c
           c
           t
           cos
           *
           -
           0
           d
           π
           *
           c
           t
           sin
           *
           +
           a
           b
           -
           t
           0
           π
           tube
           9
           1
           sys
           :
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           xu_grid
           21
           ≡
           yv_grid
           20
           ≡
           xyplane
           0
           ≡
           surface_hide
           true
           ≡
           proportional_axes
           xyz
           ≡
           enhanced3d
           u
           u
           2
           1
           sys
           ≡
           bottle
           view
           v1
           100
           v2
           -
           2
           1
           sys
           ≡
           8
           1
           sys
           :
        
      
    
     
       
         
           v1
        
      
    
     
       
         
           v2
        
      
    
     
       
         
           obj
           250
           250
           2
           1
           sys
           Draw3D
        
      
    
     
       
         
           Darstellung mit Standardpalette 
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           user_preamble
           set style fill transparent solid 0.7
           set view 60, 30, 1.3, 1.1
           2
           1
           sys
           ≡
           xu_grid
           50
           ≡
           yv_grid
           29
           ≡
           enhanced3d
           t
           t
           2
           1
           sys
           ≡
           palette
           blue
           green
           yellow
           red
           4
           1
           sys
           ≡
           xyplane
           0
           ≡
           proportional_axes
           xyz
           ≡
           cbtics
           0
           0
           2
           1
           sys
           π
           π
           2
           1
           sys
           set
           ≡
           bottle
           9
           1
           sys
           :
        
      
    
     
       
         
           obj
           250
           250
           2
           1
           sys
           Draw3D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           user_preamble
           set view 60, 30, 1.3, 1.1
           1
           1
           sys
           ≡
           enhanced3d
           none
           ≡
           xu_grid
           10
           ≡
           yv_grid
           20
           ≡
           xyplane
           0
           ≡
           surface_hide
           true
           ≡
           proportional_axes
           xyz
           ≡
           cbtics
           0
           0
           2
           1
           sys
           π
           π
           2
           1
           sys
           set
           ≡
           bottle
           9
           1
           sys
           :
        
      
    
     
       
         
           obj
           250
           250
           2
           1
           sys
           Draw3D
        
      
    
     
       
         
           o
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           proportional_axes
           xyz
           ≡
           head_angle
           10
           ≡
           3
           1
           2
           1
           sys
           5
           5
           2
           1
           sys
           vector
           head_both
           true
           ≡
           head_length
           1
           ≡
           head_type
           empty
           ≡
           1
           1
           2
           1
           sys
           3
           5
           2
           1
           sys
           vector
           unit_vectors
           true
           ≡
           head_angle
           90
           ≡
           5
           2
           2
           1
           sys
           3
           0
           2
           1
           sys
           vector
           10
           1
           sys
           :
        
      
    
     
       
         
           obj
           250
           200
           2
           1
           sys
           Draw2D
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           restart
           MaximaControl
        
         
           Restart complete.
        
      
    
     
       
         
           msg
           descriptive
           load
           Maxima
           :
        
      
    
     
       
         
           S
           pidigits.data
           file_search
           read_matrix
           Maxima
           :
        
      
    
     
       
         
           p
           title
           Frequency of the digits in π
           ≡
           S
           piechart_description
           2
           el
           proportional_axes
           xy
           ≡
           xrange
           1
           -
           1.8
           2
           1
           sys
           ≡
           axis_top
           false
           ≡
           axis_bottom
           false
           ≡
           axis_left
           false
           ≡
           axis_right
           false
           ≡
           xtics
           false
           ≡
           ytics
           false
           ≡
           xaxis
           false
           ≡
           7
           1
           sys
           5
           1
           sys
           :
        
      
    
     
       
         
           p
           Draw2D
        
      
    
     
       
         
           xa
        
      
    
     
       
         
           drawEN
        
      
    
     
       
         
           obj
           proportional_axes
           xyz
           ≡
           head_length
           0.1
           ≡
           head_angle
           10
           ≡
           0
           0
           0
           3
           1
           sys
           1
           0
           0
           3
           1
           sys
           vector
           head_both
           true
           ≡
           head_type
           empty
           ≡
           0
           0
           0
           3
           1
           sys
           1
           1
           0
           3
           1
           sys
           vector
           head_type
           nofilled
           ≡
           0
           0
           0
           3
           1
           sys
           1
           1
           1
           3
           1
           sys
           vector
           xyplane
           0
           ≡
           grid
           true
           ≡
           11
           1
           sys
           :
        
      
    
     
       
         
           obj
           Draw3D
        
      
    
     
       
         
           hea
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CHAPTER 4. 2D GRAPHICS OBJECTS

bars(b1; b2; b3...)

This is a low level object for bar charts. The individual bars are given by lists with
position x, height h and width b:

$

&

%

x
h
b

Specifying the bars as individual arguments is uncomfortable. You can use Maxima
functions to extract the arguments from a matrix:
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CHAPTER 4. 2D GRAPHICS OBJECTS

boxplot_description(M, option1,...)

Box-and-whisker-plots visualize parameters of random distributions (minimum, maxi-
mum, median, lower and upper quartile). The option range allows to set limits for outliers
in terms of the interquartile range.

M Data matrix m ˆ n, each of the n columns is a sample of m values.

box_width (default 3/4): relative width of the boxes, must be within [0,1].

box_orientation (default vertical): possible values: vertical and horizontal.

range (default 8): Sets a factor f , such that values which are by more than f times
the interquartile range o� the box are considered to be outliers. These are marked
with circles and not taken into account for the minimum and maximum indicators.
Usually f “ 1, 5.

outliers_size (default 1): size factor for the outlier-circles.

The function is de�ned in the Maxima package descriptive, which is not loaded by default
in the Maxima plugin.

In the example we are sampling throws of two dice.

If you want to specify several options to boxplot_description, then you might consider
Maxima's mapping features:
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CHAPTER 4. 2D GRAPHICS OBJECTS

ellipse(xc; yc; a; b; ang; delta;)

Draws an ellipse centered at xc, yc with the radii a and b, starting at angle ang until
angle ang+delta.

Caution! In Maxima 5.47 delta is multiplied by 2.

Options

nticks Number of sampling points

transparent (true) �lled or un�lled sector. Actual transparency must be set by
fill_color in RGBA format.

fill_color (red) �ll color in RGBA format.

border (true) draw the border

line_type (solid) line type for the border

line_width line width for the border

key (none) legend entry

color (blue) line color
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CHAPTER 4. 2D GRAPHICS OBJECTS

errors(l1; l2;...)

Plots error bars. The arguments are lists, depending on the type of the error bars.

∆x ∆x

∆y

∆y

x

y

yH

y

yL

xL x xH

non-symmetric symmetric

Options

error_type Type of error bars (x, y, xy or boxes)
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CHAPTER 4. 2D GRAPHICS OBJECTS

explicit(fpxq; x; xmin;xmax)

Plots an explicit function ypxq within a given range of the variable x.

Use the option filled_func to shade areas between functions (here we use y “ 0 as limit)

Martin Kraska 42 2023-09-29



CHAPTER 4. 2D GRAPHICS OBJECTS

histogram_description(data; option1; option2...)

Creates the graphics elements for a histogram plot of a sample data. The speci�c options
must be given as separate arguments (not as a list). Use apply() to map from a list to
function arguments

Options speci�c to histogram_description .

nclasses (10): number of classes or list with the limits and an optional number of
classes :

$

&

%

xmin

xmax

nk

or

"

xmin

xmax

frequency (absolute) scaling of the class values:

absolute Number of values in the class

relative Fraction of values in the class

percent Fraction of values in %

density Mean density of the distribution (fraction divided by width of the
classes)

htics (auto) Tick location on the horizontal axis. Possible values, auto, endpoints,
intervals or a list with labels
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CHAPTER 4. 2D GRAPHICS OBJECTS

image(Matrix; xmin; ymin; xmax; ymax)

Plots matrices of real values as color values (heat map) in the xy-plane with given axes
limits.
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CHAPTER 4. 2D GRAPHICS OBJECTS

implicit(f(x; y); x; xmin; xmax; y; ymin; ymax)

Plots implicit functions fpx, yq “ 0 using the Marching squares algorithm. The sampling
grid is de�ned by the options

ip_grid Number of sampling intervals in x- and y-direction

ip_grid_in Number of secondary interval
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CHAPTER 4. 2D GRAPHICS OBJECTS

label(list1, list2,...)

Inserts text labels at speci�ed locations. The arguments are lists of three entries

$

&

%

text
x
y

Options

label_alignment horizontal alignment: center (default) or left, right

label_orientation horizontal (default) or vertical
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CHAPTER 4. 2D GRAPHICS OBJECTS

parametric(x(t); y(t); t; tmin; tmax)

Parametric functions.
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CHAPTER 4. 2D GRAPHICS OBJECTS

piechart\_description(data; option1; option2...)

Pie chart. data is a list or a vector. The options need to be provided as function
arguments.

The function returns a list of lists. The second entry of top level list is the actual diagram
object. Therefore, the function has to be used with index 2 as in the example.

The diagram is assembled using ellipse() objects, Therefore it su�ers from a bug in
Maxima 5.47 (sector angle is double the speci�ed value).

Options

sector_colors (random) list with sector colors

pie_center

"

0
0

center of the pie

pie_radius (1) radius of the pie
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CHAPTER 4. 2D GRAPHICS OBJECTS

points(matrix)

Plot points from

� a matrix of two columns (�rst column: x-values, second column: y-values) or

� a matrix of two rows and more than two columns (�rst row: x-values, second row:
y-values) or

� a row or column vector (entries taken as y-value, index taken as x-value)

Options

point_size (1)

point_type (plus). Point type given as number or as name, see section (3.5).

points_joined (false):

false no additional lines

true connect points by lines

impulses vertical lines to the x-axis

Random yvalues plotted over their index
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CHAPTER 4. 2D GRAPHICS OBJECTS

polar(r; phi; min; max)

2D-curve, given in polar coordinates rpφq.

Martin Kraska 50 2023-09-29



CHAPTER 4. 2D GRAPHICS OBJECTS

polygon()

Filled polygon. Arguments:

� Two lists: one containing the x-values and the second containing the y-values.

� One lists of n lists: each containing the xand y-values of a vertex.

Here we demonstrate both versions.
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CHAPTER 4. 2D GRAPHICS OBJECTS

quadrilateral(p1; p2; p3; p4)

This is an alternative to a polygon with four points. Yet the input is di�erent, each
argument is a two-element list with the vertex coordinates.
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CHAPTER 4. 2D GRAPHICS OBJECTS

rectangle(p1; p2)

Rectangle, drawn between two points given as coordinate lists.
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CHAPTER 4. 2D GRAPHICS OBJECTS

region(condition; x; xmin; xmax; y; ymin; ymax)

Fill a region within the given limits, where it meets a given logical condition.
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CHAPTER 4. 2D GRAPHICS OBJECTS

triangle(p1; p2; p3)

Triangle given by three lists of vertex coordinates.
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CHAPTER 4. 2D GRAPHICS OBJECTS

vector(p; d)

Arrow with vector components d starting at point p. Both arguments are lists with 2
coordinate entries.

Options

head_angle (45) Angle between the arrow heads and the segment in °

head_both (false) A single head if false or two heads if true

head_length (2) Head length in units of the x-axis

head_type (filled): filled, nofilled: open, empty: closed but not �lled

unit_vectors (false)if true, the vector is scaled to length 1.
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Here we demonstrate the available objects for 3D graphics, i.e. for use with Draw3D() or
the Draw3D region. For some of the objects, we also explain some of the most important
options. The Draw Description snippet is a good source on available options.
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cylindrical(r(z;φ);z;zmin;zmax;φ;φmin;φmax)

This function plots surfaces given by the radius as a function of z and of the azimuth
angle φ.

This is an example of how to color the plot based on the angular coordinate and based
on a custom palette.
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elevation_grid(M; x0; y0; w; h)

3D representation of amˆnmatrix of z-values. M11 corresponds to x “ x0 and y “ y0`h,
Mmn corresponds to x “ x0 ` w and y “ y0.

The example shows a 8 ˆ 6 random matrix with a custom color palette. In Gnu-
plot, the faces have uniform color. In order to have color gradients on a face, the
interpolate_color option can be used.
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explicit(z(x; y); x; xmin; xmax; y; ymin; ymax)

Plots explicit functions zpx, yq within given ranges of the variables x and y.

Options:

palette list of colors. (color) The value from enhanced3D is uniformly mapped to
this list.

enhanced3d (z) how to generate values for coloring. Speci�ed as list with the
entries fpx, y, zq, x, y, z

Here we use the default color map to color by the distance from the xy-plane f “ |z|.
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implicit(fpx, y, zq;x;xmin;xmax;y;ymin;ymax;z;zmin;zmax)

Visualization of implicit functions fpx, y, zq “ 0 within the given range of the variables.

� Number of intervals for the Marching Cubes Algorithm is set by the options x_voxel,
y_voxel, z_voxel.
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label(list1, list2,...)

Inserts text labels at speci�ed locations. The arguments are lists of four entries

$

’

’

&

’

’

%

text
x
y
z

Options

label_alignment horizontal alignment: center (default) or left, right

label_orientation horizontal (default) or vertical
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parametric(fx; fy; fz; t; tmin; tmax)

Parametric curve, given by three functions of parameter t. The sampling density is con-
trolled by option nticks.
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parametric_surface(fx;fy;fz;u;umin;umax;v;vmin;vmax)

Parametric surface, given by three functions of two parameters. The following example
is inspired by the Gnuplot examples page. The sampling density of the parameters is
controlled by the options xu_grid and yv_grid.
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This example is from the Maxima documentation:
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points(matrix)

Plot points at px, y, zq given by

� a 3 ˆ n matrix, each column is a point or

� a n ˆ 3 matrix, each row is a point.

Options

enhanced3d (color) coloring of the points. If you specify a list of two entries.j
is the index of the point in the matrix (row index) and fpjq is an arbitrary
function of that index

"

fpjq

j

point_size (1)

point_type (plus). Point type given as number or as name.

points_joined (false):

false no additional lines

true connect points by lines (color is averaged between adjacent points)

impulses vertical lines to the x-axis
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quadrilateral(p1; p2; p3; p4)

This draws a quadrilateral. Each argument is a three-element list with the vertex coordi-
nates.
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spherical(r; a; amin; amax; z; zmin; zmax)

Surface given by a radius rpα, β) in spherical coordinates with α being the azimuth angle
counted from the x-axis and β being the angle from zenith (north pole).
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triangle(p1; p2; p3)

Triangle given by three lists of vertex coordinates.
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tube(x; y; z; r; p; min; max)

Tubular surface, given by center line coordinates x, y, z and radius r as function of the
path parameter p.

The example is a Klein bottle. The individual parts have colors assigned, which are only
relevant for the surface grid.

Here we use a non-standard palette for coloring by path parameter.

Martin Kraska 70 2023-09-29



CHAPTER 5. 3D GRAPHICS OBJECTS

The same plot with surface grid instead of shading. Shading is disabled using enhanced3D=none.
The surface grid respects the color speci�cation.
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vector(p; d)

Arrow with vector components d starting at point p. Both arguments are lists with 2
coordinate entries.

Options

head_angle (45) Angle between the arrow heads and the segment in °

head_both (false) A single head if false or two heads if true

head_length (2) Head length in units of the x-axis

head_type (filled): filled, nofilled: open, empty: closed but not �lled

unit_vectors (false)if true, the vector is scaled to length 1.
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6 Curve Fitting

Contents

6.1 Fit of a Cubic Parabola to 5 Random Points . . . . . . . . . 74

6.2 Fit of a Circle to 4 Points . . . . . . . . . . . . . . . . . . . . 75

Fit.sm

The function Fit() is an interface to Maxima's lsquares package for �tting mathematical
models to data. It is augmented by MSE() and Residuals() for evaluation of the quality of
the �t and Assign() for converting the result represented by equations into assignments.

Fit(data; vars; eqn; pars; init; tol)

data (matrix) Given data. Each line is a a data point, each column is a variable.

vars (list) Names of variables, one for each column in data.

eqn Equation or expression (which will augmented by “ 0), which contains the
Variables listed in vars vars and the model parameters listed in pars.

pars (list) Names of the free model parameters in eqn.

init (list) Initial values for the numeric search for optimal parameter values.

tol (optional number) Tolerance for the precision of the model parameters.

The function returns a list of Boolean equations parameter = value. This list can be
used for value assignment using the function Assign() , e.g. if you want to plot the model
curve.

The quality of the curve �t can be evaluated using the functions MSE() and Residuals(),
which return the mean square error and the deviation between model and data respec-
tively.

Note that the �t is a numeric procedure. The result may depend on the initial values of
the parameters.
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             [Maxima Draw3D] contour (=none): Art der Höhenlinien. none: keine, base: auf der xy-Ebene, surface: auf der 3D-Fläche, both: auf xy-Ebene und Fläche, map: auf xy-Ebene und Blickrichtung senkrecht. Globale Option.
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             [Maxima Draw] draw_realpart (=true) Realteil zur Darstellung komplexer Werte verwenden.
          
          
           
             
             [Maxima Draw] draw_realpart (=true) use real part for plotting complex values.
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             [Maxima Draw] enhanced3d (=none) Farbpalette, none: 3D Flächen als Gitter zeichnen (Steuerung mit color und surface_hide), true: Farbe anhand des z-Werts, Liste  [f(x,y,z), x, y, z]: Farbe anhand der Funktion f, Liste [f(u,v),u,v]: Farbe anhand der Flächenparameter oder Liste [f(k), k ]: Farbe anhand der Punktnummer in points() Objekten.
          
          
           
             
             [Maxima Draw3D] enhanced3d (=true) coloring of surfaces by z-value, (control using color und surface_hide), false: draw 3D surfaces as grid, or list [f(x,y,z), x, y, z]: coloring according to function f or list [f(u,v),u,v] or list [f(k), k ] (k being the point counter in points() objects).
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             [Maxima Draw] key_pos (="", entspricht top_right): Legendenposition. Gültige Werte: top_left, top_center, top_right, center_left, center, center_right, bottom_left, bottom_center, bottom_right. Globale Option.
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             [Maxima Draw] label_alignment (=center), left oder right: horizontale Ausrichtung von Beschriftungen.
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             :
          
        
      
       
         
           
             
             [Maxima Draw] label_orientation (=horizontal) oder vertical: Ausrichtung von Texten.
          
          
           
             
             [Maxima Draw] label_orientation (=horizontal) or vertical: orientation of text labels.
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             :
          
        
      
       
         
           
             
             [Maxima Draw] line_type (=solid) Linienart. Alternativen: dots (für alle Formate) oder wenn von Gnuplot unterstützt: dashes, short_dashes, short_long_dashes, short_short_long_dashes. 
          
          
           
             
             [Maxima Draw] line_type (=solid) line type. Other options: dots (for all formats) or if supported by Gnuplot: dashes, short_dashes, short_long_dashes, short_short_long_dashes. 
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             line_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] line_width (=1) Linienstärke, >0. 
          
          
           
             
             [Maxima Draw] line_width (=1) line width, >0. 
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             :
          
        
      
       
         
           
             
             [Maxima Draw] logcb (=false) oder true: logarithmische Farbskale. Globale Option.
          
          
           
             
             [Maxima Draw] logcb (=false) or true: log scale of the colorbar. Global option.
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             :
          
        
      
       
         
           
             
             [Maxima Draw] logx (=false) oder true: logarithmische x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] logx (=false) or true: log scale of x-axis. Global option.
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             :
          
        
      
       
         
           
             
             [Maxima Draw2D] logx_secondary (=false) oder true: logarithmische zweite x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw2D] logx_secondary (=false) or true: log scale of secondary x-axis. Global option.
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             logx_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logy (=false) oder true: logarithmische y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] logy (=false) or true: log scale of y-axis. Global option.
          
          
           
             logy
             logy
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] logy_secondary (=false) oder true: logarithmische zweite y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw2D] logy_secondary (=false) or true: log scale of secondary y-axis. Global option.
          
          
           
             logy_secondary
             logy_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] logz (=false) oder true: logarithmische z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] logz (=false) or true: log scale of z-axis. Global option.
          
          
           
             logz
             logz
             :
          
        
      
       
         
           
             
             [Maxima Draw] nticks (=29): Punktezahl für die Kurvenabtastung
          
          
           
             
             [Maxima Draw] nticks (=29): number of points for curve sampling (explicit and parametric)
          
          
           
             nticks
             nticks
             :
          
        
      
       
         
           
             
             [Maxima Draw] palette (=color) Standard-Farbpalette, gray: Graustufen, Liste [Farbe1, Farbe2...]: Interpolation über die gegebenen Farben. Globale Option. 
          
          
           
             
             [Maxima Draw] palette (=color) default color palette, gray: gray levels, or list [color1, color2...]: interpolation over the given set of colors. Global option. 
          
          
           
             palette
             palette
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_size (=1) Größe von points()-Symbolen.
          
          
           
             
             [Maxima Draw] point_size (=1) size of points()-symbols.
          
          
           
             point_size
             point_size
             :
          
        
      
       
         
           
             
             [Maxima Draw] point_type (=1) Symbol für points()-Objekte, Name oder Kennzahl: none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5, circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10, filled_dwn_triangle 11, diamant 12, filled_diamant 13
          
          
           
             
             [Maxima Draw] point_type (=1) type of points() objects, name or key number: none -1, dot 0, plus 1, multiply 2, asterisk 3, square 4, filled_square 5, circle 6, filled_circle 7, up_triangle 8, filled_up_triangle 9, down_triangle 10, filled_down_triangle 11, diamant 12, filled_diamant 13
          
          
           
             point_type
             point_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] points_joined (=false), true oder impulses: Verbindungsart von points()-Objekten
          
          
           
             
             [Maxima Draw] points_joined (=false), true or impulses: how to join points
          
          
           
             points_joined
             points_joined
             :
          
        
      
       
         
           
             
             [Maxima Draw] proportional_axes (=none), xy oder xyz: Achsen mit gleicher Skalierung). Globale Option.
          
          
           
             
             [Maxima Draw] proportional_axes (=none), xy or xyz: set axes of equal scaling). Global option.
          
          
           
             proportional_axes
             proportional_axes
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] surface_hide (=false) oder true: Ausblendung verdeckter Flächen bei Linienrasterdarstellung. Nur relevant wenn enhanced3D=false.
          
          
           
             
             [Maxima Draw3D] surface_hide (=false) or true: handling of hidden lines in surface grids. Only relevant if enhanced2d=false.
          
          
           
             surface_hide
             surface_hide
             :
          
        
      
       
         
           
             
             [Maxima Draw] terminal (=screen) Ausgabeart. screen: Separates Ausgabefenster, png, jpg, gif, eps, svg, pdf, animated_gif: Gnuplot Ausgabeformat. Globale Option. Nur für Experten. Nutzen Sie das Name-Argument von Draw2D()/3D().
          
          
           
             
             [Maxima Draw] terminal (=screen) separate interactive terminal window,  png, jpg, gif, eps, svg, pdf, animated_gif: gnuplot output format. Global option. Only for experts. Use name argument of Draw2D/3D instead.
          
          
           
             terminal
             terminal
             :
          
        
      
       
         
           
             
             [Maxima Draw] title (="") Überschrift für das Diagramm. Globale Option.
          
          
           
             
             [Maxima Draw] title (="") headline for the plot. Global option
          
          
           
             title
             title
             :
          
        
      
       
         
           
             
             [Maxima Draw] transform (=none) Koordinatentransformation, für 2D als Liste [f1(x,y), f2(x,y), x, y], für 3D als Liste [f1(x,y), f2(x,y), f3(x, y, z), x, y, z]
          
          
           
             
             [Maxima Draw] transform (=none) co-ordinate transformation, for 2D as list [f1(x,y), f2(x,y), x, y], for 3D as list [f1(x,y), f2(x,y), f3(x, y, z), x, y, z]
          
          
           
             transform
             transform
             :
          
        
      
       
         
           
             
             [Maxima Draw] transparent (=false) oder true: ob Rechtecke, Polygone oder Ellipsen transparent sein sollen (bei false werden sie gefüllt). Für echte Transparenz nutzen Sie die Option color mit dem Transparenzwert aa der RGBA Farbspezifikation "#rrggbbaa". 
          
          
           
             
             [Maxima Draw] transparent (=false) fill objects with border, true: don't fill (make them transparent). For actual transparency use RGBA color "rrggbbaa" with the color option.
          
          
           
             transparent
             transparent
             :
          
        
      
       
         
           
             
             [Maxima Draw] unit_vectors (=false) oder true: Vektoren in originaler Länge oder als Einheitsvektoren zeichnen.
          
          
           
             
             [Maxima Draw] unit_vectors (=false) draw vectors in original length, true: draw unit vectors.
          
          
           
             unit_vectors
             unit_vectors
             :
          
        
      
       
         
           
             
             [Maxima Draw] user_preamble (="") Zeichenkette oder Liste von Zeichenketten, die unmittelbar vor dem eigentlichen Diagrammbefehl an Gnuplot übergeben werden. Globale Option.
          
          
           
             
             [Maxima Draw] user_preamble (="") string or list of strings, gnuplot commands placed  immediately before the plot commands. Global option
          
          
           
             user_preamble
             user_preamble
             :
          
        
      
       
         
           
             
             [Maxima Draw] view (=(60,30)) Blickrichtung (Zenithwinkel von z aus, Azimutwinkel von x aus). Globale Option.
          
          
           
             
             [Maxima Draw] view (=(60,30)) view direction (zenith angle from z, azimut angle from x). Global option.
          
          
           
             view
             view
             :
          
        
      
       
         
           
             
             [Maxima Draw] wired_surface (=false) oder true: Gitternetz auf eingefärbten Flächen anzeigen oder nicht. Globale Option.
          
          
           
             
             [Maxima Draw] wired_surface (=false) no grid on colored surfaces, true: draw grid on surfaces. No color control. Global option.
          
          
           
             wired_surface
             wired_surface
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] x_voxel (=10) x-Bereichsteilung für den Marching-Cubes-Algorithmus bei implizit gegebenen Flächen.
          
          
           
             
             [Maxima Draw3D] x_voxel (=10) number of x steps for the Marching Cubes algorithm (for implicit 3D functions). Also used for region().
          
          
           
             x_voxel
             x_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] y_voxel (=10) y-Bereichsteilung für den  Marching-Cubes-Algorithmus bei implizit gegebenen Flächen.
          
          
           
             
             [Maxima Draw3D] y_voxel (=10) number of y steps for the Marching Cube algorithm (for implicit 3D functions). Also used for region().
          
          
           
             y_voxel
             y_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] z_voxel (=10) z-Bereichsteilung für den Marching-Cubes-Algorithmus bei implizit gegebenen Flächen.
          
          
           
             
             [Maxima Draw3D] z_voxel (=10) number of z steps for the Marching Cube algorithm (for implicit 3D functions). 
          
          
           
             z_voxel
             z_voxel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis (=false) oder true: Anzeige der x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis (=true): draw x-axis. false: don't draw x-axis. Global option
          
          
           
             xaxis
             xaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis (=false) oder true: Anzeige der y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis (=true): draw y-axis. false: don't draw y-axis. Global option
          
          
           
             yaxis
             yaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis (=false) oder true: Anzeige der z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis (=true): draw x-axis. false: don't draw x-axis. Global option.
          
          
           
             zaxis
             zaxis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_color (=black) Farbe x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis_color (=black) color of the x-axis. Global option.
          
          
           
             xaxis_color
             xaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_color (=black) Farbe y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis_color (=black) color of the y-axis. Global option.
          
          
           
             yaxis_color
             yaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis_color (=black) Farbe z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis_color (=black) color of the z-axis. Global option
          
          
           
             zaxis_color
             zaxis_color
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] xaxis_secondary (=false) oder true: Nutzung einer zweiten x-Achse (oben) für die nachfolgenden Objekte.
          
          
           
             
             [Maxima Draw2D] xaxis_secondary (=false) or true: use the secondary x-axis (top) for subsequent objects.
          
          
           
             xaxis_secondary
             xaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw2D] yaxis_secondary (=false) oder true: Nutzung einer zweiten y-Achse (rechts) für die nachfolgenden Objekte
          
          
           
             
             [Maxima Draw2D] yaxis_secondary (=false) or true: use the secondary y-axis (right) for subsequent objects
          
          
           
             yaxis_secondary
             yaxis_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_type (=dots) oder solid: Linienart der x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis_type (=solid) or dots. Global option.
          
          
           
             xaxis_type
             xaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_type (=dots) oder solid: Linienart der y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis_type (=solid) or dots. Global option.
          
          
           
             yaxis_type
             yaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis_type (=dots) oder solid: Linienart der z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis_type (=solid) or dots. Global option.
          
          
           
             zaxis_type
             zaxis_type
             :
          
        
      
       
         
           
             
             [Maxima Draw] xaxis_width (=1) Linienbreite der x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xaxis_width (=1). Global option
          
          
           
             xaxis_width
             xaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] yaxis_width (=1) Linienbreite der y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yaxis_width (=1). Global option
          
          
           
             yaxis_width
             yaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] zaxis_width (=1) Linienbreite der z-Achse. Globale Option.
          
          
           
             
             [Maxima Draw3D] zaxis_width (=1). Global option.
          
          
           
             zaxis_width
             zaxis_width
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel (="") x-Achsenbeschriftung. Globale Option.
          
          
           
             
             [Maxima Draw] xlabel (="") label of the x-axis. Global option
          
          
           
             xlabel
             xlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel(="") y-Achsenbeschriftung. Globale Option.
          
          
           
             
             [Maxima Draw] ylabel (="") label of the y-axis. Global option
          
          
           
             ylabel
             ylabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] zlabel (="") z-Achsenbeschriftung. Globale Option.
          
          
           
             
             [Maxima Draw] zlabel (="") label of the z-axis. Global option
          
          
           
             zlabel
             zlabel
             :
          
        
      
       
         
           
             
             [Maxima Draw] xlabel_secondary (="") Beschriftung der zweiten x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xlabel_secondary (="") label of the secondary x-axis. Global option
          
          
           
             xlabel_secondary
             xlabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ylabel_secondary (="") Beschriftung der zweiten y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ylabel_secondary (="") label of the secondary y-axis. Global option
          
          
           
             ylabel_secondary
             ylabel_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange (=auto) oder Liste [min,max]: x-Achsenbereich. Globale Option.
          
          
           
             
             [Maxima Draw] xrange (=auto) or list [min,max]: range of the x-axis. Global option
          
          
           
             xrange
             xrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange (=auto) oder Liste [min,max]: y-Achsenbereich. Globale Option.
          
          
           
             
             [Maxima Draw] yrange (=auto) or list [min,max]: range of the y-axis. Global option
          
          
           
             yrange
             yrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] zrange (=auto) oder Liste [min,max]: z-Achsenbereich. Globale Option.
          
          
           
             
             [Maxima Draw] zrange (=auto) or list [min,max]: range of the z-axis. Global option.
          
          
           
             zrange
             zrange
             :
          
        
      
       
         
           
             
             [Maxima Draw] xrange_secondary (=auto) oder Liste [min,max]: Bereich der zweiten (oberen) x-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xrange_secondary (=auto) or list [min,max]: range of the secondary (top) x-axis. Global option.
          
          
           
             xrange_secondary
             xrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] yrange_secondary (=auto) oder Liste [min,max]: Bereich der zweiten (rechten) y-Achse. Globale Option.
          
          
           
             
             [Maxima Draw] yrange_secondary (=auto) or list [min,max]: range of the secondary (right) y-axis. Global option.
          
          
           
             yrange_secondary
             yrange_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics (=auto): automatische x-Achsmarken, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] xtics (=auto): automatic x ticks, none: no x ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option
          
          
           
             xtics
             xtics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics (=auto): automatische y-Achsmarken, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] ytics (=auto): automatic y ticks, none: no y ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option. 
          
          
           
             ytics
             ytics
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics (=auto): automatische z-Achsmarken, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] ztics (=auto): automatic z ticks, none: no x ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option.
          
          
           
             ztics
             ztics
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary (=auto): automatische Marken an der sekundären (oberen) x-Achse, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_secondary (=auto): automatic ticks on the secondary (top) x-axis, none: no ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option.
          
          
           
             xtics_secondary
             xtics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary (=auto): automatische Marken an der sekundären (rechten) y-Achse, none: keine, Zahl: Schrittweite, Liste mit [min, Schritt, max], oder set() von Zahlen: explizite Vorgabe der Zahlenwerte, oder set() von Listen ["text",pos] mit Vorgabe von Beschriftung und Position. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_secondary (=auto): automatic ticks on the secondary (right) y-axis, none: no ticks, number: tick interval, list of [min, step, max], or set() of numbers: explicit tick values, or set() of lists ["text",pos] for spec of position and text. Global option.
          
          
           
             ytics_secondary
             ytics_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_axis (=false): x-Achsmarken am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_axis (=false): ticks on the boundary, true: ticks on the axis. Global option.
          
          
           
             xtics_axis
             xtics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_axis (=false): y-Achsmarken am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_axis (=false): ticks on the boundary, true: ticks on the axis. Global option.
          
          
           
             ytics_axis
             ytics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_axis (=false): z-Achsmarken am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ztics_axis (=false): ticks on the boundary, true: ticks on the axis. Global option.
          
          
           
             ztics_axis
             ztics_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_secondary_axis (=false): Marken an der sekundaren (oberen) x-Achse am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_secondary_axis (=false): ticks on the secondary (top) boundary, true: ticks on the axis. Global option.
          
          
           
             xtics_secondary_axis
             xtics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_secondary_axis (=false): Marken an der sekundaren (rechten) y-Achse am Rand, true: an der Achse. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_secondary_axis (=false): ticks on the secondary (right) boundary, true: ticks on the axis. Global option.
          
          
           
             ytics_secondary_axis
             ytics_secondary_axis
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate (=false): x-Achsmarken nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_rotate (=false): horizontal tick labels, true: vertical tick labels. Global option.
          
          
           
             xtics_rotate
             xtics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate (=false): y-Achsmarken nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_rotate (=false): horizontal tick labels, true: vertical tick labels. Global option.
          
          
           
             ytics_rotate
             ytics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] ztics_rotate (=false): z-Achsmarken nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] ztics_rotate (=false): horizontal tick labels, true: vertical tick labels. Global option.
          
          
           
             ztics_rotate
             ztics_rotate
             :
          
        
      
       
         
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): Marken an der sekundären (oberen) x-Achse nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] xtics_rotate_secondary (=false): don't rotate ticks of the secondary (top) x-axis, true: rotate by 90°. Global option.
          
          
           
             xtics_rotate_secondary
             xtics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): Marken an der sekundären (rechten) y-Achse nicht drehen, true: um 90° drehen. Globale Option.
          
          
           
             
             [Maxima Draw] ytics_rotate_secondary (=false): don't rotate ticks of the secondary (right) y-axis, true: rotate by 90°. Global option
          
          
           
             ytics_rotate_secondary
             ytics_rotate_secondary
             :
          
        
      
       
         
           
             
             [Maxima Draw] xu_grid (=30) Abtastpunkte in x- oder u-Richtung 
          
          
           
             
             [Maxima Draw] xu_grid (=30) sampling points in x- or u-direction 
          
          
           
             xu_grid
             xu_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw] yv_grid (=30) Abtastpunkte in y- oder v-Richtung 
          
          
           
             
             [Maxima Draw] yv_grid (=30) sampling points in y- or v-direction 
          
          
           
             yv_grid
             yv_grid
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] xyplane (=false): xy-Koordinatenebene automatisch anordnen, Zahl: z-Koordinate. Globale Option.
          
          
           
             
             [Maxima Draw3D] xyplane (=false): automatic allocation of the xy-plane, real number: xy-plane intersects the z-axis at this level. Global option.
          
          
           
             xyplane
             xyplane
             :
          
        
      
       
         
           
           Objekte 
        
        
      
       
         
           
             
             [Maxima Draw2D] bars(b1,b2...) Säulendiagramm, Säulen gegeben durch Listen (x,h,w). Optionen: key, color, fill_color, fill_density und line_width.
          
          
           
             
             [Maxima Draw2D] bars(b1,b2...) vertical bars, given as lists [x,h,w]. Options: key, color, fill_color, fill_density and line_width.
          
          
           
             _
             bars
             _
             bars
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Stellt eine Matrix in 3D dar. M_11 bei x=x0,y=y0+h, M_mn bei x=x0+w,y=y0. Optionen:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d und color
          
          
           
             
             [Maxima Draw3D] elevation_grid(matrix,x0,y0,w,h) Draws a m x n-matrix in 3D. M_11 at x=x0,y=y0+h, M_mn at x=x0+w,y=y0. Options:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             _1
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             [Maxima Draw3D] elevation_grid(Matrix,x0,y0,w,h) Stellt eine Matrix in 3D dar. M_11 bei x=x0,y=y0+h, M_mn bei x=x0+w,y=y0. Optionen:  xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color
          
          
           
             
             [Maxima Draw3D] cylindrical(r(φ,z),z,zmin,zmax,φ,φmin,φmax) Draws a function in cylindrical coordinates. Options: xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d and color.
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             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,φ2) Ellipse, zentriert bei xc, yc mit den Halbachsen a und b, von Startwinkel φ1 und Winkelbreite dφ. In Maxima 5.47 wird die Breite doppelt gezählt. Optionen nticks, transparent, fill_color, border, line_width, line_type, key und color. 
          
          
           
             
             [Maxima Draw2D] ellipse(xc,yc,a,b,φ1,dφ) plots an ellipse centered at [xc, yc] with horizontal and vertical semi axis a and b, respectively, starting at φ1 with an amplitude dφ. Note that in Maxima 5.47 the amplitude is doubled. Options: nticks, transparent, fill_color, border, line_width, line_type, key and color. 
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             [Maxima Draw2D] errors(e1,e2...) Punkte mit Fehlerbalken, horizontal, vertical oder beide, abhängig von der Option error_type. Argumente für error_type = x: Listen [x, y, xdelta] oder [x, y, xlow, xhigh]. Argumente für error_type = y; Listen [x, y, ydelta] oder [x, y, ylow, yhigh]. Argumente für error_type = xy oder error_type = boxes: Listen [x, y, xdelta, ydelta] oder [x, y, xlow, xhigh, ylow, yhigh]. Optionen: error_type, points_joined, line_width, key, line_type, color, fill_density, xaxis_secondary, and yaxis_secondary 
          
          
           
             
             [Maxima Draw2D] errors(e1,e2...) Draws points with error bars, horizontally, vertically or both, depending on the value of option error_type. If error_type = x, arguments are lists [x, y, xdelta] or [x, y, xlow, xhigh]. If error_type = y, arguments are lists [x, y, ydelta] or [x, y, ylow, yhigh]. If error_type = xy or error_type = boxes, arguments are lists [x, y, xdelta, ydelta] or [x, y, xlow, xhigh, ylow, yhigh]. Options: error_type, points_joined, line_width, key, line_type, color, fill_density
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             [Maxima Draw2D] explicit(f,x,xmin,xmax) zeichnet eine Funktion f von x von xmin bis xmax. Optionen: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color und color
          
          
           
             
             [Maxima Draw2D] explicit(f,x,xmin,xmax) plots explicit function f, with variable x taking values from xmin to xmax. Options: nticks, adapt_depth, draw_realpart, line_width, line_type, key, filled_func, fill_color and color
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             :
          
        
      
       
         
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) zeichnet eine Funktion f von x und y im Bereich xmin bis xmax und ymin bis ymax Optionen: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d und color. 
          
          
           
             
             [Maxima Draw3D] explicit(f,x,xmin,xmax,y,ymin,ymax) plots the explicit function f, with variable x taking values from xmin to xmax and variable y taking values from ymin to ymax. Options: draw_realpart, xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, and color. 
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             [Maxima Draw2D] image(Matrix,x0,y0,w,h)  Farbdarstellung einer m x n Matrix entsprechend der Option palette im Gebiet (x0,y0) bis (x0+w,y0+h)
          
          
           
             
             [Maxima Draw2D] image(matrix,x0,y0,w,h)  plots matrix in the rectangular region from vertex (x0,y0) to (x0+w,y0+h) according to global option palette.
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             :
          
        
      
       
         
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax) 2D Darstellung einer implizit gegebenen Funktion im angegebenen Variablenbereich (marching squares Algorithmus). Optionen: ip_grid, ip_grid_in, line_width, line_type, key, color
          
          
           
             
             [Maxima Draw2D] implicit(f,x,xmin,xmax,y,ymin,ymax) plots the implicit function defined by f, with variable x taking values from xmin to xmax, and variable y taking values from ymin to ymax. Options: ip_grid, ip_grid_in, line_width, line_type, key, color
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             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax) 3D Darstellung einer implizit gegebenen Funktion im angegebenen Variablenbereich (Marching Cubes Algorithmus). Optionen: x_voxel, y_voxel, z_voxel, ip_grid_in, line_width, line_type, wired_surface, enhanced3D, color [Maxima Draw]
          
          
           
             
             [Maxima Draw3D] implicit(f,x,xmin,xmax,y,ymin,ymax,z,zmin,zmax) plots the implicit surface defined by f, with variable x taking values from xmin to xmax, variable y taking values from ymin to ymax and variable z taking values from zmin to zmax. This object implements the marching cubes algorithm. Options: x_voxel, y_voxel, z_voxel, line_width, line_type, key, wired_surface, enhanced3d,and color
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             [Maxima Draw2D and 3D] label(list) Beschriftung, im 2D gegeben als Liste (text,x,y), im 3D als Liste (text,x,y,z), spezielle Optionen: color, label_alignment, label_orientation
          
          
           
             
             [Maxima Draw2D and 3D] label(list) text label specified in 2D as list [text,x,y], in 3D as list [text,x,y,z], Options: color, label_alignment, label_orientation
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             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) parametrisch gegebenen Funktion. Optionen: nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             
             [Maxima Draw2D] parametric(fx,fy,p,pmin,pmax) plots the parametric function fx, fy  with parameter p taking values from pmin to pmax. Options: nticks, line_width, line_type, key, color, enhanced3d
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             [Maxima Draw3D] parametric(fx,fy,fz,p,pmin,pmax) Parametrische Funktion, beschrieben durch drei Koordinatenfunktionen des Parameters p im gegebenen Bereich von pmin bis pmax. Optionen: nticks, line_width, line_type, key, color, enhanced3d
          
          
           
             
             [Maxima Draw3D] parametric(fx,fy,fz,p,pmin,pmax) parametric function, described by three coordinate functions of parameter p, taking values from pmin to pmax. Options: nticks, line_width, line_type, key, color, enhanced3d
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             points(matrix) Punkte, 2D: n x 2 oder 2 x n -> n Punkte bei (x,y) oder 1 x n oder n x 1 -> n Punkte bei (index,y). 3D: n x 3 oder 3 x n -> Punkte bei (x,y,z). Spezielle Optionen: points_joined, point_type, point_size [Maxima Draw2D/3D] 
          
          
           
             
             [Maxima Draw2D and 3D] points(matrix) 2D: n x 2 or 2 x n -> n points at (x,y) or 1 x n or n x 1 -> n points at (index,y). 3D: n x 3 or 3 x n -> points at (x,y,z). Specific options: points_joined, point_type, point_size, enhanded
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             points
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             [Maxima Draw2D] points(lx,ly) Punkte, gegeben durch zwei Listen der x- und y-Koordinaten. Spezielle Optionen: points_joined, point_type, point_size [Maxima Draw2D] 
          
          
           
             
             [Maxima Draw2D] points(lx,ly) points given by two lists, special options: points_joined, point_type, point_size
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             points
             :
          
        
      
       
         
           
             
             [Maxima Draw3D] points(lx,ly,lz) zeichnet Punkte, gegeben durch drei Listen, spezielle Optionen: points_joined, point_type, point_size
          
          
           
             
             [Maxima Draw3D] points(lx,ly,lz) points given by three lists, pecial options: points_joined, point_type, point_size
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             [Maxima Draw2D] polar(r,φ,φmin,φmax) zeichnet Funktionen, die in Polarkoordinaten gegeben sind (Radius r als Funktion des Winkels φ). Spezielle Optionen: key, nticks, line_width, line_type, color
          
          
           
             
             [Maxima Draw2D] polar(r,φ,φmin,φmax) draws functions given in polar co-ordinates (radius r as function of angle φ). Special options: key, nticks, line_width, line_type, color
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             [Maxima Draw2D] polygon(matrix)  Polygon durch die als n x 2 Matrix gegebenen Punkte. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             
             [Maxima Draw2D] polygon(matrix)  polygon defined by matrix (each row one point). Special options: transparent, fill_color, border, line_width, key, line_type color 
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             [Maxima Draw2D]  polygon(lx,ly)  Zeichnet ein Polygon durch die als x- und y-Listen gegebenen Punkte. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type color 
          
          
           
             
             [Maxima Draw2D]  polygon(lx,ly)  polygon defined by two lists. Special options: transparent, fill_color, border, line_width, key, line_type, color 
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             [Maxima Draw2D/3D] quadrilateral(l1,l2,l3,l4) Viereck, gegeben durch Listen der Eckkoordinaten 2D: [x,y] oder 3D: [x,y,z]. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color, enhanced3D (nur 3D)
          
          
           
             
             [Maxima Draw2D/3D] quadrilateral(l1,l2,l3,l4) quadrilateral given by lists  of vertex coordinates: [x,y] in 2D or [x,y,z] in 3D. Special options: transparent, fill_color, border, line_width, key, line_type, color, enhanced3D (3D only)
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             [Maxima Draw2D] rectangle(l1,l2) Rechteck gegeben durch Koordinatenlisten [x,y] gegenüberliegender Ecken. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             
             [Maxima Draw2D] rectangle(l1,l2) specified by lists [x,y] of opposite corners. Special options: transparent, fill_color, border, line_width, key, line_type, color 
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             :
          
        
      
       
         
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Füllt das Gebiet wo expr wahr (true) ist im Bereich von xmin, xmax, ymin, ymax. Optionen: fill_color, key, x_voxel, y_voxel
          
          
           
             
             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Fills the region where expr is true in the domain given by xmin, xmax, ymin, ymax. Options: fill_color, key, x_voxel, y_voxel
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             [Maxima Draw2D] region(expr,x,xmin,xmax,y,ymin,ymax) Füllt das Gebiet wo expr wahr (true) ist im Bereich von xmin, xmax, ymin, ymax. Optionen: fill_color, key, x_voxel, y_voxel
          
          
           
             
             [Maxima Draw3D] spherical(r, a, mina, maxa, z, minz, maxz) plots function r(a, z) defined in spherical coordinates, with azimuth a taking values from mina to maxa and zenith z taking values from minz to maxz. Options: xu_grid, yv_grid, line_type, key, wired_surface, enhanced3d, and color.
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             [Maxima Draw2D/3D] triangle(l1,l2,l3)  Dreieck, gegeben durch Koordinatenlisten [x,y] (2D) oder [x,y,z] (3D) der Ecken. Spezielle Optionen: transparent, fill_color, border, line_width, key, line_type, color 
          
          
           
             
             [Maxima Draw2D/3D] triangle(l1,l2,l3)  given by co-ordinate lists [x,y] (2D) or [x,y,z] (3D) of the corners.Options: transparent, fill_color, border, line_width, key, line_type, color 
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             [Maxima Draw3D]  tube(fx,fy,fz,fr,p,pmin,pmax)  Röhre, gegeben durch Mittellinie mit fx,fy,fz und den Radius fr als Funktionen des Parameters p. Spezielle Optionen:  xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, color, capping.
          
          
           
             
             [Maxima Draw3D]  tube(fx,fy,fz,fr,p,pmin,pmax)  tube, given by functions fx,fy,fz of the centerline and radius function fr of the parameter p from pmin to pmax. Special options:  xu_grid, yv_grid, line_type, line_width, key, wired_surface, enhanced3d, color, capping.
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             [Maxima Draw2D/3D]  vector(l1,l2)  Pfeil,  gegeben durch Koordinatenlisten (x,y) (2D) oder (x,y,z) (3D) der Endpunkte. Spezielle Optionen:  head_both, head_length, head_angle, head_type, line_width, line_type, key color.
          
          
           
             
             [Maxima Draw2D/3D]  vector(l1,l2)  given by co-ordinate lists [x,y] (2D) or [x,y,z] (3D) of the end points. Spezielle Optionen:  head_both, head_length, head_angle, head_type, line_width, line_type, key color.
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             [Maxima]  set(e1, e2,...) Maxima set (Liste in geschweiften Klammern)
          
          
           
             
             [Maxima]  set(e1, e2,...) Maxima set (in Maxima this is a list in curly braces)
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             [Maxima] args(expr) Liste der Argumente von expr 
          
          
           
             
             [Maxima] args(expr) list of the top level arguments of expr. Extracts lines from matrices.
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             [Maxima] apply(f, Liste) Macht die Elemente der Liste zu Argumenten von f. apply(f,args(matrix)) wandelt eine Matrix in Argumente einer Funktion um -> f(row1, row2,...) 
          
          
           
             
             [Maxima] apply(f, list) applies the elements of list as arguments to f. apply(f,args(matrix)) converts a matrix into arguments of a function -> f(row1, row2,...)
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CHAPTER 6. CURVE FITTING

6.1 Fit of a Cubic Parabola to 5 Random Points

A cubic parabola fpxq “ ax3 ` bx2 ` cx ` d is to be �tted to �ve points with xi “ 1 . . . 5
and yi being random values between 0 and 1.

First, the data matrix is created by combining the vectors with the x-values and the y-
values. Then, the model function fpxq is de�ned. The free parameters must be unde�ned
variables. If in doubt, apply the function Clear() to the parameters.

Now the Fit() function is applied. Display the result with Context menu> Optimiza-
tion> None. Otherwise the results aren't displayed properly.

Assign() is used to convert the equations from Fit() into parameter assignments. Thus
the model function can be plotted using the result of the �t.

The quality of the �t is evaluated by the model-data-deviations (residuals) and by the
mean square error (MSE). These functions take the same arguments like Fit().
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CHAPTER 6. CURVE FITTING

6.2 Fit of a Circle to 4 Points

Find a circle with center point xx, yc and radius R such that it is an optimal �t to four
given points.

The circle is represented by an implicit equation fpx, yq “ 0. The involved variables are
cleared, just to be sure they are unde�ned.

There is no solution such that all points are on the perimeter of the circle, so an approxi-
mate solution is to be found. The function Fit() is used to determine the parameters of
the circle such that the mean square error of fpx, yq “ 0 at the data points is minimized.

The resulting equations are converted to assignments. In the plot the implicit equation
is used directly. Center and data points are added to the plot.

For an exact solution, the function fpx, yq should be zero at the data points. The deviation
is shown using Residuals(). This isn't the real distance between points and perimeter
but it is approximately proportional to it.
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7 Algebraic Equations

Contents

7.1 Scalar Equations . . . . . . . . . . . . . . . . . . . . . . . . . 77

7.2 Systems of Equations . . . . . . . . . . . . . . . . . . . . . . . 79

Solve.sm

The function Solve() is an interface to Maxima's solve() function. It's advantages are:

� Symbolic solution of linear and non-linear systems of equations.

� No need for initial guesses or search intervals.

� Simple handling of multiple solutions.

� The function can handle units of measurement.

Sometimes the symbolic expressions become too complex and Solve() doesn't �nd a
solution. Then you can try the native SMath solver solve() or roots() or the function
FindRoot() from the Nonlinear Solvers Plugin.

Solve(eqn,vars)

eqn equation or list or vector of equations. If the expressions don't contain a
Boolean equal sign, then implicitly “ 0 is added.

vars variable or list or vector of variables to solve for.

The solution comes as an equation or a list of equations name=value. If there is more
then one solution, these are given as Matrix of equations or lists of equations.

The solution can be converted into assignments using the function Assign(). In case of
multiple solutions you need to decide, which one to use for assignment. Select the solution
by using the appropriate element index with the solution matrix.

Note: Always use symbolic � or even better, no � optimization/evaluation for results
display. The equations contain unde�ned variables and those can't be displayed with
numeric optimization.
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CHAPTER 7. ALGEBRAIC EQUATIONS

7.1 Scalar Equations

Single Solution

Single equations and variables can be speci�ed as scalar expressions without using lists
or matrices.

In the case of a single solution the result is a single equation without any wrapping
structure. To actually assign the solution to the variable, use Assign():

Alternatively, you can use the substitution function at() from the Custom Functions
plugin.

Multiple Solutions

Multiple solutions for a single variable are displayed as a list of equations. You can select
one of them by using an element index.

While solving and selecting solutions, the variables must be unde�ned. Delete eventual
values using Clear().
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7.2 Systems of Equations

Single Solution

Systems of equations are given as vectors or lists. Also the variables are given as vectors
or lists. In the case of a single solution, it is returned as a list of equations, one for each
variable.

Assign() converts all equations in the argument (no matter what structure that is) to
assignments.

The variant with at() does not work out of the box, because L doesn't actually store the
result but rather the command to create it.

at() expects equations as speci�cation for substitution.

If the expression is converted to displayed form (this is what the function simp() does),
then at() can handle the assignment.

Multiple Solutions

Here we show how to build the system of equations one by one. This can be useful if you
want to explain the meaning of these equations separately.

Note that assigning an equation to a variable requires brackets around the equation. The
assignment operator := has higher priority than the Boolean equal.
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The plot shows that there are two solutions:

Multiple solutions with multiple variables are returned as a row vector of lists. The
solutions can be accessed via an element index.
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8 Ordinary Di�erential Equations

Contents
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ODE2.sm

Maxima has many features for ordinary di�erential equations (ODE). Some of them are:

� The function ODE.2() for symbolic solution of ODE up to second order.

� The plot functions for direction �elds in the Maxima package drawdf.
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CHAPTER 8. ORDINARY DIFFERENTIAL EQUATIONS

8.1 Function ODE.2()

The function ODE.2() solves ordinary di�erential equations up to second order.

ODE.2(ode;f(t),t)

ode di�erential equation

f(t) unknown function

t independent variable

The result is a Boolean equation which can be used by Assign() for assignment.
Depending on the order of the ODE, the solution contains one or two integration
constants, named c (�rst order) or k1 and k2 (second order).

This is demonstrated for the initial value problem

d2

dt2
wptq ` ω2wptq “ 0, wp0q “ 1,

d

dt
wptq

ˇ

ˇ

ˇ

ˇ

t“0

“ 0

First, the general solution is obtained:

The message �ω is assumed to be positive� means that Maxima internally asked for the
sign of ω. The plugin captures such questions and always responds with +. The message
is integrated in the result for transparency. This way the user can see that the assumption
was made.

The user can store such assumptions in advance and thus avoid questions by Maxima.

The return value is a Boolean equation. Using Assign() this equation can be converted
into a de�nition of the unknown function. The solution contains one or two constants of
integration depending on the order of the ODE. Their name is c (�rst order) or k1 and
k2 (second order).

The constants are determined from the initial conditions wp0q “ 1 and w1p0q “ 0. Note
that you can't write the latter as dwp0q{dt because wp0q isn't a function of t any more.
Thus the derivative yields zero. Therefore, the derivative has to be computed �rst and
then the value t “ 0 has to be substituted using at().
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Solution and assignment are written in a single formula.

In order to plot the solution, ω must be given a value.
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CHAPTER 9. ADVANCED TOPICS

9.1 Custom De�nitions and Translations

Custom de�nitions and translations are stored in the con�g �le maxima.xml, which resides
in the top level maxima plugin directory. If the Development tools plugin is installed,
then you can open the plugin directory via Insert> Development Tools> Plugin's
folder> MaximaPlugin.

Note that such con�gurations are local to your SMath installation. Documents which
make use of such features aren't portable, i.e. they won't work on other computers. Yet
it enables you to experiment with translations without access to the source code.

Example

Let's assume we want to add handling of the SMath function round(x,n) which is not
available in Maxima. In Maxima, we have just round(x), which rounds to zero decimal
places.

First, we have to de�ne a helper function in Maxima, to which we later translate round(x,n):

round2(x,n):=round(x*10^n)/10^n$

We add this de�nition to maxima.xml :

<CustomLoadCommands>

<Command>round2(x,n):=round(x*10^n)/10^n$</Command>

</CustomLoadCommands>

Second, we need to add translation rules to map round(x,n) to round2(x,n):

<ConvertFromSMathToMaxima>

<Expression regex="round\(" replace="round2("></Expression>

</ConvertFromSMathToMaxima>

As it may happen that a symbolic expression returned from Maxima contains round(x),
we also want to add a translation into the SMath equivalent round(x,0). This is a bit
more involved, as we have to isolate the argument of round(), in order to add a second
one:

<ConvertFromMaximaToSMath>

<Expression regex="round\((.+)\)" replace="round($1,0)"></Expression>

</ConvertFromMaximaToSMath>

Note that by the time you are reading this, the above translation has been implemented
in the plugin.
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The plot above is generated using a Maxima Draw2D() plot region.
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